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Philip Tory’s Professional Technical Writing Course Training Manual  

I originally created this workbook for delegates who attended my Technical Writing 
Course, which I fine-tuned over the years. I have delivered this course to several hundred 
satisfied individuals, across 11 countries, since 2002. 

It assumes that you are a fairly competent user of MS Word, that you are reasonably 
computer literate, and that you have a good grasp of written and spoken English.  

You also need to be Technical! You can’t explain a subject properly to the target users 
unless you know enough about that subject area, or can learn it quickly and well enough. 

I retired in 2017, so I am now passing on this Training Resource free of charge, so that 
you – and your colleagues – can be competent and professional Technical Authors too. 

This manual must NOT be sold in any form, nor may it be used for running training 
sessions / courses for which money is charged. This is a FREE resource for sharing. 
 

I hope you enjoy it and benefit from it! 

God bless you. 

 
 

Philip Tory, BSc (Hons) Applied Physics with Electronics, Dip.M. 

Consultant Technical Author and International Trainer, Gloucester UK 

Industry: Former Draughtsman; Electronics Engineer (Concorde Flight Computers); Technical Training, 
Sales and Marketing Manager (car park control systems, leisure management systems); Software Product 
and Quality Manager; Technical Author, and Company Director of Authorgraphic Ltd. 

Authoring: I started writing technical documentation in the 1990s. In 2000, I started my own technical writing 
business. This grew to nearly 200 clients, large and small; from low-tech (e.g. how to run a Lawn Care 
franchise) up to extreme-tech (how to process waste at a Nuclear Power Station; technical specification for 
the European Extremely Large Telescope). And anything in between (e.g. Operations and Quality Control 
Procedures for refuelling aircraft at Heathrow Airport). 

See http://www.technical-author.org.uk/subject_areas.html 

You can read more on my Training web site www.technicalwritingcourse.co.uk, 

 
Published May 2018. 

© 2002-2018 Copyright Philip Tory, Gloucester UK. 
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MODULE 1 

 

MODULE 1 – Technical Writing in Plain English 
This Training Workbook contains my Professional Technical Writing Course, which I have 
successfully used to train hundreds of people across 11 countries. It teaches you the essentials of 
good writing practice for technical publications.  

I have tried to present it in a user-friendly style, to make it readable and easy to understand.   

Work through it, study every page, highlight things that seem important to you, and 
write your comments on the pages.   

Do the Exercises. This is a WORKBOOK!  So WORK at it!   

Read it again from time to time, and Develop New Habits!  Happy Writing!  

Philip Tory   BSc (Hons), Dip.M., Technical Writer and International Trainer, Gloucester UK 

 

If you can, work through the course in twos or in a small group. Organise time together to do this.  
 
Test your technical communication skills, and test your understanding! 

What makes Good Documentation? 

What are the characteristics? What do we need to think about when writing good documentation? 

Write your thoughts here: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Is it easy to write good documentation? _______________________________________ 
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Good documentation – 

 Targets the audience 

 Is task-oriented 

 Uses step-by-step instructions 

 Uses shorter words, sentences and paragraphs. 

What do writers find difficult? 

 Where do I start? 

 What do I include/exclude? 

 How much detail do I need? 

 What is the right Structure? 

 How do I target / write for the user? 

 What about the writing style & layout? 

 How do I make it readable / clear / appealing? 

What makes Bad Documentation? 

From replies to our pre-course questionnaire, delegates often mentioned the following points: 

 Bad structure 

 Poor spelling and grammar 

 Cannot find the answer 

 Dry and long-winded / dull and boring 

 Out of date 

 Insufficient illustrations / diagrams 

 Index poor / non-existent 

 They ASSUME you already know      =  ASS | U | ME 

 

 – When you ASSUME something, it makes an ASS of U and an ASS of ME ! 
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What is Technical Writing? 
Technical Writing is a conversation between the writer and the user. An effective technical writer 
predicts the questions a user would ask about the subject, and answers them clearly and concisely. 

 
“Technical writing is communication. The primary aim is to convey specific information to a target 
reader group for a particular purpose. Essentially, it explains scientific, technical and instructional 
subjects. “ 

1
 

 

Stated another way, Technical Writing is – 

Translating technical ideas into words that a target audience will understand. 

This Training Course focuses on the essential elements of how to write effective technical / 
instructional documentation. 

What is – or isn’t – ‘Plain English’? 
Plain English is essential for good, user-friendly documentation. Here are some definitions: 

Plain English focuses on being a flexible and efficient writing style that readers can understand in 
one reading. It uses only as many words as are necessary. It combines clear, concise expression; 
an effective structure; and good design. It tries to avoid obscurity, inflated vocabulary, and 
convoluted sentences. Plain English lets readers concentrate on the message instead of 
complicated language. 

2
 

“Plain English is a writing style that is clear, concise, and easy to understand. It is not bureaucratic 
or convoluted. Plain English involves writing the way you talk (sometimes called ‘natural writing’), 
using active voice, using personal pronouns, being concrete and concise, and organizing your 
documents in a logical and readable form.” 

3
 

“Plain English is clear, straightforward expression, using only as many words as are necessary. 
It is language that avoids obscurity, inflated vocabulary and convoluted sentence construction. 
It is not baby talk, nor is it a simplified version of the English language ... It makes sure that the 
audience understands the message easily.” 

4
 

Note: 

 Most effective people at work use plain English by habit. Their colleagues, staff and customers 
appreciate it. 

 Plain English uses the right wording for the target audience. 

 It is clearer to a wider range of readers. 

 It removes clutter, and minimises details that add little or no value. 

 Plain English is a skill you can learn and a habit you can develop. 

 

 
“If you can’t explain it simply, you don’t understand it well enough” – Albert Einstein 

 

                                                      

1
 Wikipedia 

2
 Wikipedia. 

3
 Society of Technical Communicators. 

4
 Professor Robert Eagleson. 
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Bad English 

In the past, we have all seen examples of muddy, unclear, pompous, 
ambiguous, bureaucratic and officious writing. Chief culprits were 
local authorities, pensions companies, banks, building societies, the 
Inland Revenue and so on. Their written material and forms was 
often confusing and meaningless. 

Thankfully, in recent years, things have improved. Many 
organisations now train their staff in plain English. Plain English is 
now mandatory for all UK government web sites.  

 

Gobbledegook Turns People OFF 

“Gobbledegook” (sometimes called “Technobabble” or “management psychobabble”) means the 
kind of bad English where a writer over-complicates a simple message. This can overwhelm the 
reader with pompous, technical or unfamiliar words. 

 Fowler’s Modern English Usage (1998 edition) describes gobbledygook as  
“official, professional, or pretentious verbiage or jargon”. 

 It is usually a simple idea expressed in an excessively convoluted way. It may use five or ten 
words instead of one; or use a five-syllable word where one or two syllables would suffice. 

 “Gobbledygook may indicate a failure to think clearly, contempt for the readers, or more 
probably a mixture of both.” ...  

 “It is sloppy jargon intended to confuse non-specialists.” 
5
 

Written material like this can make the reader feel frustrated and angry.   Examples: 

“A wheel or disk mounted to spin rapidly about an axis and also free to rotate about one or both of 
two axes perpendicular to each other and the axis of spin so that a rotation of one of the two 
mutually perpendicular axes results from application of torque to the other when the wheel is 
spinning and so that the entire apparatus offers considerable opposition depending on the angular 
momentum to any torque that would change the direction of the axis of spin.”

6
  

 [84 words in one sentence! Reading ease = 0] 

 

“It is the only platform that allows you to create multiple presentation experiences from a single 
application process definition. This powerful capability means that you can support contextual 
applications for different user types, deliver to multiple delivery channels and support different 
languages and brands without duplicating effort. Additionally, eConn supports different 
presentation experiences, including: online (rich client and thin client – typically used for disability 
access and mobile devices), offline, portal or composite clients. Users are able to create these 
experiences without needing to know scripting or the underlying technologies, such as JSR168 for 
portals.” 

7
 [Reading ease = 11.9] 

 

“If you ask me for a straight answer, then I shall say that, as far as we can see, looking at it by and 
large, taking one thing with another in terms of the average of departments, then in the final 
analysis it is probably true to say, that at the end of the day, in general terms, you would probably 
find that, not to put too fine a point on it, there probably wasn't very much in it one way or the 
other.” – the fictional permanent secretary, Sir Humphrey Appleby.  [84 words, Reading ease = 13.8] 

 

“That does not indicate that we do not have a responsibility not to discourage women.” 
8
 

Have you come across writing like this? 

                                                      
5
 Michael Shanks, former chairman of the UK National Consumer Council 

6
 Webster's Seventh New Collegiate Dictionary, defining 'gyroscope' 

7
 A software manufacturer. Name changed to protect the guilty! 

8
 Example quoted on Bigpond.net.au. 
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What if you were to translate it the other way? 

What they actually said A Gobbledygook version by a stuffy bureaucrat ...  

“England expects every man 
to do his duty.” – Lord 
Nelson. 

“England anticipates that, as regards the current emergency, 
personnel will face up to the issues and exercise appropriately the 
functions allocated to their respective occupational groups.” 

9
 

“Mrs Smith didn’t want the 
job.” 

“Verbal contact with Mrs Smith regarding the attached notification 
of promotion has elicited the attached representation intimating 
that she prefers to decline the assignment.” 

10
 

“I see one third of a nation 
ill-housed, ill-clad, 
ill-nourished.” 
– Franklin Roosevelt. 

“It is evident that a substantial number of people within the 
Continental Boundaries of the United States have inadequate 
financial resources with which to purchase the products of 
agricultural communities and industrial establishments. It would 
appear that for a considerable segment of the population, 
possible as much as 33.33% of the total, there are inadequate 
housing facilities, and an equally significant proportion is deprived 
of the proper types of clothing and nutriment.” 

11
  

Doesn’t everyone use plain English? 

Unfortunately they don’t. Some people find it hard to communicate in simple, everyday language. A 
few of them speak complicated language all the time. Here is an example from a film:  

From the film ‘i, ROBOT’ 
 

Det. Spooner: 
  “So, Dr Calvin, what actually do you do around here?” 

Dr. Calvin:  “My general fields are Advanced Robotics and 
Psychiatry, although I specialise in hardware-to-wetware 
interfaces, in an effort to advance the USR Robotics 
Anthropomorphisation Program.” 

Spooner:  (pause) “So, what actually do you do around here?” 

Dr. Calvin:  “I make the robots seem more human.” 

Spooner:  “Now, wasn’t that easier to say?” 

Dr. Calvin:  “Not really ... no.” 

 

 
She’s right. To the specialist, no, it’s not easier! They spend their lives using that level of language. 

(And in case you were wondering, anthropomorphisation means, “applying human or animal qualities 
to inanimate objects”.) 
 

 

                                                      
9
 Alan Herbert, Oxford MP 

10
 Stuart Chase, “Gobbledegook” 

11
 Stuart Chase, “The Tyranny of Words” 
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Some authors instinctively write Good English 

Agatha Christie is one of the top ten, best-selling, English fiction authors of the last hundred years, 
with worldwide sales topping two billion. (Hercule Poirot, Miss Marple, etc.) 
 

Dr Pernilla Danielsson is from the Department of English at the University of Birmingham. She 
used textual analysis to discover the type of words that Christie used in her detective novels. The 
purpose was to investigate the differences between the writing style of Agatha Christie, and other 
English authors. Dr Danielsson noted that Agatha “used conversational language throughout 
her writing ... Christie’s books score highly in readability because she used short words, 
short sentences and a limited vocabulary. 

12
 

 

 “Agatha doesn’t challenge you with her vocabulary, 
therefore you can concentrate on the clues and the plot.” 

 
So that’s what we need to aim for in the way we write: to help the reader to “concentrate on the 
story”. 
 

Your Aim 

Your aim is – 

 To communicate 

 To help people to learn 

 To help people to understand 

 NOT to show off or to impress people how clever you are! 

Plain English often uses a conversational style. Don’t be afraid of it – readers like it! 

Benefits of Plain English 

Plain English is using the correct language for the subject matter and the target audience. 

Benefits: 

 People read it quicker, understand it better, and remember longer. 

 Procedures are more efficient. 

 Productivity is higher. 

 Complaints and Support Calls are fewer. 

 It improves customer understanding and satisfaction, product credibility and company image. 

 It increases sales, cash flow, and profits. Referrals from happy customers are the best and 
cheapest form of advertising. 

                                                      
12

 [Source: ‘The Agatha Christie Code’, first broadcast on ITV1, 26 December 2005.] 
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Plain English saves Time and Money  

All over the English-speaking world, governments, corporations, professional services 
organisations, and businesses large and small are using plain English. It saves time and money, 
improving profits and credibility. 

 Plain English has saved the British Government about £500 million in the last 20 years. 
13

 

 In 1983, the UK Home Office produced a new plain English application for British Citizenship 
that takes people 15 minutes less to complete than the old one. This saved the public 20,000 
hours a year. 

14
 

 The Department of Health and Social Security introduced plain language application forms 
for legal aid in 1984. It cost the Department about £25,000 to develop and test the forms, but 
they saved £1,500,000 in staff time per year. * 

 At GEC, a new manual in plain English saved 125 support calls a month from just one 
customer. Applying the average cost of support calls, GEC estimates that it saves between 
$22,000 and $375,000 a year for each business customer who uses the new manual.

15
 

 In Canada, the Royal Insurance Company unveiled its “simple English” Select Homeshield 
Policy for home insurance. Sales increased 38%, from $58 million to $79 million in the same 
year. * 

 The State of Victoria, Australia, saved $400,000 by simplifying the wording on a summons 
forms so people could understand it. They were able to reassign 16 clerks and 10 police 
officers. * 

 In 2006, the Arizona Department of Revenue rewrote many of its standard letters into plain 
language. Phone calls went down so much in 2007 that workers were able to process about 
30,000 more claims than they had in the previous year. 

16
 

 British Telecom reduced complaints by 25% by using Plain English in their telephone bills. 
17

 

 Royal Mail saved £500,000 in 9 months by redesigning one form in Plain English. 

 In the US, General Electric saved $270,000 by rewriting manuals into plain English. 

 The US Navy could save $250 to $350 million a year by using Plain English. 

 USA Plain Writing Act 2010. Each call for clarification from taxpayers costs the IRS agency 
$25, and it received 110 million calls in 2010 alone*. The new law states that every federal 
agency must communicate to the public in “clear, concise, well-organised” language, 
emphasising the potential cost savings from translating legalese to lucid prose. Clear 
communications improve compliance with rules and reduce errors, which lower enforcement 
and administrative costs. 

18
 

         [* That’s US$2.75 billion – Ed.] 

 
(Various sources) 

                                                      
13

 Preston City Council web site. 
14

 The Plain Language Association International. * 
15

 “Technical Communication” (1995). 
16

 “The Arizona Republic” newspaper. 
17

 Siegel & Gale. ** 
18

 Cass Sunstein, Regulatory Chief, US Inland Revenue Service 2011. 
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It’s quicker in Plain English! 

Study conducted by the American Institutes for Research. 

In a plain language document, people find information faster, understand it more accurately, and 
are more satisfied with using it. 
 

In a study comparing original and plain language regulations from the Federal Communications 
Commission, both inexperienced and experienced users did much better with the plain language 
version: 
 

They found the information faster 
Measured in minutes per problem 

Type of user Original Plain Language 

Experienced user 2.4 mins 1.5 mins 

Inexperienced user 3.5 mins 1.7 mins 

 

 

They answered more questions correctly 
Measured as number of questions answered correctly 

Type of user Original Plain Language 

Experienced user 64% correct 82% correct 

Inexperienced user 43% correct 86% correct 

 

 

They rated the new version EASIER TO USE 
Measured on a scale of 1–5 (where 1 = Easy and 5 = Hard) 

Type of user Original Plain Language 

Experienced user 4.2 (hard) 1.8 (easy) 

Inexperienced user 4.6 (hard) 2.0 (easy) 
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Who is the best equipped to translate into Plain English? 

You?  Or the Reader? 

Suppose 300 non-specialists will eventually read your documentation. Do you want them all to 
understand the same message? If it is not well written, in easy English, each reader could interpret 
a slightly different message. 

 
Consider the following: 
 

If you write in Difficult English  

If you write the original documentation in high-level, complicated language, it may make complete 
sense to you. You might ask, “Well, what’s wrong with it? I understand it just fine!” 

However, each of the 300 readers will then unconsciously try to translate it into their personal 
everyday language and understanding – their own ‘Plain Language’. You might end up with 300 

different versions, complete with misunderstandings, mistakes, support calls or accidents.  
 

If you write in Plain English  

If you write a Plain Language document that ALL the readers can understand without effort, then 
ALL 300 readers will receive the same message. YOU know the subject best, so write what is best 

for ALL the end readers.  
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Write to COMMUNICATE, not to show off! 

Unless you are writing a University Thesis, you win no respect for being academic, pompous or 
long-winded, if you leave the readers bewildered. 

 Don’t try to impress people – try to help them to understand. 

 Keep the message at the level of the reader, so that they can learn from you and enjoy doing 
so. 
 

Conversational style 

Talk to your reader in a friendly, open way. Be personal. 
 

 
“I notice that these Upgrade Notes are now in layman’s terms. Please produce the 
next Manual in this style!” 

“I like the simpler terminology - the Speaking Voice.” 

– Comments from end users of a Leisure Centre Management 
software system, for which I had written the documentation. 

 

 
Imagine this scenario: 

 Imagine you are speaking to the reader on the telephone, and can see them by a remote 
television link. Suppose you have to give them step-by-step instructions about how to do a task. 

 Talk them through it; explain what they need to do, and don’t be afraid to be direct. They need 
to understand clearly what to do – they don’t want to make a mistake any more then you do. 

 Now use the same words in your written instructions. Remember to keep them clear, logical and 
step-by-step. 

This is probably the best way to write your instructions and procedures. 
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Paragraphs 

A paragraph should be about one main idea. Don’t make paragraphs too long: 4 or 5 sentences 
are usually enough. 

Sentences 

The sentences in a paragraph need to support this main idea. A sentence needs one or more 
complete thoughts. In terms of grammar, it normally needs a SUBJECT (the person or thing taking 
the action), a VERB (the ‘doing’ word) and an OBJECT, (the person or thing receiving the action). 

Not too many ideas in a sentence 

Readers can only absorb so much information at once. Too many ideas lead to hard work or 
confusion. Sentences exist to divide ideas into “bite-sized chunks” that we can easily digest.  

If someone has to read something more than once, it is too long or too complex: so, simplify it! 

In brief 

 Avoid long words, sentences, paragraphs, or sections. Allow the reader to absorb ideas more 
easily. (Would you read this training manual if it were one continuous paragraph?) 

 Define special terms. Use bold to make them stand out on the page: it’s easier to find them. 

 Explain acronyms on their first use in a chapter, and use as few as possible. As a guideline, 
don’t use an acronym unless you are going to use it at least three times. (Use a footnote or 
Glossary section for acronyms and special terms). 
 

Average Sentence Length?  15-20 words 
Long words in long sentences in long paragraphs require a higher level of intelligence and 
education to understand. To reach a wide readership, write for the lowest skill level of the target 
readership – to make it accessible to the whole reader group. 

Long words might make you sound pompous, pretentious or arrogant. They are also more difficult 
to understand and more awkward to read. 

Some writers love long sentences: their readers usually don’t! (I once took an 80-word sentence 
back to the writer for explanation. She couldn’t understand it either, and asked me who wrote it!)  

Trying to explain complex issues in one long sentence makes matters worse. Here is a 71-word 
example from a Guidance document produced by a leading Bank Insurance company:  

“A managing agent must ensure that the documentation of the theory, assumptions, and 
mathematical and empirical basis underlying the internal model is thorough, sufficiently detailed and 
sufficiently complete enough to ensure that an independent knowledgeable third party could 
understand the model framework, its methodology, the underlying assumptions, and the limits of 
applicability of the model and in principle reproduce the model outputs if all the parameters and 
exposure data were available.” 

Researchers in English-speaking countries agree that the average sentence length should be 
around 15 to 20 words. Vary the sentence length, to make it interesting. Sometimes difficult 
procedures need longer sentences; but if a sentence is 30-35 words or more, see if you can split it. 

Shorter is better 

Short sentences get to the point. Use them for emphasis. 

Big Words? 

Sometimes you might need to use big words for accuracy; but those times are few and far between. 
Use simple, familiar words instead of unfamiliar words. Use a well-known term instead of the latest 
bureaucratic expression. Use a short word rather than a long one, if it means the same thing. For 
example, use “buy” instead of “purchase”.  

For many people, more syllables means it is slower to read and harder to understand. 
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Punctuation - what is it for? 

When we talk to somebody face to face, we use intonation (tone of voice) and we use pauses for 
emphasis. There are also visual signals – our facial expressions, our body language, to help the 
listener to understand what we are saying.  

When we write, there are no visual or verbal signals. The only aid we have is punctuation. This 
helps the reader to reconstruct the way we would have spoken the words. They can then imagine 
our intonation, our pauses and our meaning – the verbal signals. That’s why it is so important.  

Wrong punctuation can change the message totally.  

Here is a fun example.  

Same words + different punctuation = a totally different message! 
 

Dear John, 

I want a man who knows what love is all about. 
You are generous, kind, thoughtful. People who 
are not like you admit to being useless and 
inferior. You have ruined me for other men. 
I yearn for you. I have no feelings whatsoever 
when we’re apart. I can be forever happy – will 
you let me be yours? 

Jane 

Dear John, 

I want a man who knows what love is. All about 
you are generous, kind, thoughtful people, who 
are not like you. Admit to being useless and 
inferior. You have ruined me. For other men, 
I yearn. For you, I have no feelings whatsoever. 
When we’re apart, I can be forever happy.  
Will you let me be? 

Yours, 

Jane 

Commas 

Use commas as an aid to understanding. Think of them as a brief pause between thoughts. For 

example, “If you were speaking the sentence out loud, trying to put your message very clearly, 

where would you put the commas?” 

A comma in the wrong place can change the message.  
Examples: 

Our doctor said, the man is drunk.  —  Our doctor, said the man, is drunk. 

Correct punctuation could even save someone’s life:  

Let’s go and eat Grandma!  ... or ... Let’s go and eat, Grandma!  

Examples of Correct Usage: 

 “The bar was closed, but the customers stayed to watch the 

television.” 

“Because of a flat tyre, the salesman was late for his appointment.”  

“For instance,  ... ” 

“For example,  ... ” 

“Certainly,   ...” 

“In this section, fill in the reason you were absent from work.” 

“Monday was her day off, so she went to visit her mother.” 

“Unfortunately, the system was not ready for despatch on Tuesday.” 

“As you know, the engine works best after it has warmed up.”  

“Meanwhile, you can find further information at our web site.”  

“On the other hand, the system will work better after correct adjustment.” 

“However, we don’t always know the reason why this component fails.” 

Note: Too many commas in one sentence can be confusing, so could you split a complex sentence 
into two or three separate sentences? Or is there a better way to say it? 



 1 – HOW TO WRITE GOOD DOCUMENTATION 

 

Professional Technical Writing Course, to be distributed Free of Charge. Copyright © 2018 Philip Tory, Technical Author, UK 13 
 

Apostrophes  

The apostrophe has two main functions: to show possession or omission. 

Historically, possession was indicated as in “John Smith his bookJohn Smith his bookJohn Smith his bookJohn Smith his book    ”,  

                   – which became abbreviated to “John Smith’s bookJohn Smith’s bookJohn Smith’s bookJohn Smith’s book ”. 

Possession: belonging to 

Singular: When something belongs to one person or thing, the apostrophe goes before the ‘s’ 
to show possession: 
  e.g. the student’s book;   the supervisor’s office;  the car’s wheels. 

Plural: In the plural form, the apostrophe goes after the ‘s’ to show possession: 
  e.g. the coal miners’ strike;   the dogs’ dinners (the dinners of the dogs). 

Note also: The children’s shoes;   the companies’ accounts (the accounts of the companies). 

Omission 

The apostrophe also shows when we have omitted something in a word; for example, 
“She’s been here before”; “Don’t do that!” 

Is it Its or It’s ? 

Make sure you understand the difference between its and it’s. 

Its can only mean one thing: the possessive, something that belongs to it.  

We don’t use an apostrophe with his or hers, so we don’t use one with it’s. 

 

        “its” is the only exception to the rule for apostrophes and possession.  
    Hence –  The dog wagged its tail.  The equipment blew its fuse. 

It’s can only mean a contraction of “it is” or “it has”: 

   It ’s been here for a week.   (Contraction of it has). 

   It ’s raining.     (Contraction of it is). 

Plurals 

1. Do not use an apostrophe to indicate plurals. This classic 
mistake is often seen on market stalls and is sometimes called the 
“greengrocer’s apostrophe”. 

     e.g. APPLES  not  APPLE’S;      

PEARS    not  PEAR’S, etc. 

2. Do not use an apostrophe to form a plural with numbers and 
acronyms: 

     e.g. 1980s,  not  1980’s DVDs,  not  DVD’s 

 

No, no, no, no, no! 

Semicolons  ;  

A semicolon tells the reader that the two clauses (parts of the sentence) are closely related. 
It marks a stronger pause than a comma but less final than a full stop. There is no connecting word 
such as and or but. Examples: 

“It was the best of times; it was the worst of times.”
19

 

“Alice worked hard for her exams; she passed with flying colours.” 

 “He was nervous about addressing the meeting; he asked for water several times.”  

                                                      
19

 From “A Tale of Two Cities” by Charles Dickens. 
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Colons  :  

Use a colon between two main clauses of a sentence when the second clause explains or expands 
the first. Effectively, the colon focuses the reader’s attention on what is to follow. 

(a) Use a colon to introduce or emphasise the words following. For example: 

  “They brought presents: gold, frankincense and oil at $54 a barrel.” 

  “Africa is facing a terrifying problem: perpetual drought.” 

  “Note: first check that the system is isolated from the mains.”  

(b) Use a colon for contrast. For example: 

  “He liked the new car: his son didn’t”. 

(c) Use a colon to introduce a bulleted list. 
 

Hyphens and dashes 

Use a hyphen or a dash – for emphasis! The shortcut for an ‘en-dash’ is  (use the minus 
key on the number pad). 
 

Compound words: Use a hyphen between words when their combination makes an adjective 
(a describing word) before a noun. Here are some examples:  

high-level summary long-term view  far-fetched explanation  old-fashioned design  

clear-cut decision full-time monitoring custom-built interface quick-thinking staff 

sugar-free diet up-to-date report muddle-headed thinking Carbon-neutral design 

However, when using the words without a noun after them, don’t use a hyphen. Hence; “The idea 
was far fetched”; “the interface was custom built”, etc.  

Simplify: If you can remove a word, then do so. 

Some writers have developed the habit of adding “padding” to their sentences – extra words that 
carry little or no meaning. This means that the reader has to “filter out” the irrelevant words in order 
to find the message. 

Writer George Orwell said: 

 
“Any words that don’t contribute meaning to a passage  

dilute its power. Less is always better. Always.” 
20

 
 

 
 [See more of George Orwell’s writing tips on page 144.] 

International Readers 

More than one billion people use English as a foreign language. Short sentences give 
international readers confidence and reduce translation errors. 

Long sentences: 

 Can be difficult to translate accurately. 

 Have complex structures that confuse international readers. 

 Can obscure the main point. 

 Can cause grammar mistakes. 

 Cause anxiety in people who don’t read English fluently.

                                                      
20

 From George Orwell – "Five Rules for Effective Writing", 1946 
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Exercise 1 – Sentence Length 

LONG SENTENCES: Write a short instruction about a subject of your choice, real or imaginary.  
What will you write about? What information do you want to tell people? 

1. Write the instruction using very long sentences. What’s the longest you can do?  

L
O

N
G

 S
E

N
T

E
N

C
E

S
 

 
 

2. Now, REWRITE THE SAME INFORMATION using short and medium sentences. 

Try to keep to a maximum of 15-20 words per sentence, and don’t leave anything out!  

S
H

O
R

T
 /
 M

E
D

IU
M

 S
E

N
T

E
N

C
E

S
 

 

 After you finish the exercise, answer these questions: 

1. How could you apply this in your writing at work? How might you use this in future? 
 
 

2. What difficulties would this overcome? 
 
 

3. What kinds of existing documentation would benefit? 
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Exercise 2a – Convert Long Sentences to Short 

REWRITE THIS LONG SENTENCE INTO SHORT AND MEDIUM SENTENCES. 

 Aim for a maximum of 20 words per sentence; fewer are better.  

 Do not lose any accuracy of meaning – this is a business procedure. 

 Use bullet points. 

 It might help to use a highlight pen to dot the main points that have to be checked. 

 Ask yourself, “What has this person got to do?” – and then answer the question. 

 
“The Document Administrator shall check that procedures have been formatted correctly, 
including the Footer or for Mechanical Integrity documents, the Header (Issue No. and Date, 
Revision No and date, Document Number and Title, Page Numbering and review period interval 
etc); whether any hard copies are required and if so the distribution and copy numbers, or 
alternatively for electronic only masters, that no hard copies are required, but showing who needs 
to be communicated with if the document should change (by job title); the format should comply 
with the document control template.”   [91 words. Reading ease = 24.5]. 

SHORT SENTENCES: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After you finish the exercise, answer these questions: 

1. How could you apply this in your writing at work? How might you use this in future? 
 
 
2. What difficulties would this overcome? 
 
 
3. What kinds of existing documentation would benefit? 

 
 

(After you’ve finished – see the answer on p. 130) 
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Exercise 2b more than Convert Long Sentences to Short 

REWRITE THESE LONG SENTENCES INTO SHORT AND MEDIUM SENTENCES. 

 Aim for a maximum of 20 words per sentence; fewer are better.  

 Do not lose any accuracy of meaning – this is a business procedure.    

 Use bullet points. 

 Ask yourself, what has this person got to do? Then write the answer to the question. 
 

 
“The Clinical Team Leader or designate (CTL): Develops the Clinical Management Plan (CMP) 
(Operating Procedure CS.OP.CM010, Clinical Management Plan), defines the Data Query 
process, co-ordinates the monitoring activities of the Monitor, including development and 
distribution of monitoring guidelines, and review of the associated site visit report.” [45 words] 
 
SHORT SENTENCES: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After you finish the exercise, answer these questions: 

1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 

2. What difficulties would this overcome? 
 
 
 
 

3. What kinds of existing documentation would benefit? 
 
 
 
 
 

(After you’ve finished – see the answer on p. 130) 
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ACTIVE or PASSIVE voice – what’s the difference?   
People mostly use the “Active voice” when speaking, but use the “Passive voice” when they write. 
This is why readers tend to “switch off”, even though they could have absorbed the information. 

ACTIVE 
(shorter; more direct). 

Has a feeling of Action about it. 

PASSIVE 
(longer; less direct) 

Has a less active, more passive feel. 

The goalkeeper kicks the ball. The ball is kicked by the goalkeeper. 

The car hit the tree. The tree was hit by the car. 

Unscrew the two nuts securing the air inlet 
duct. 

The two nuts securing the air inlet duct are 
unscrewed. * 

Disconnect the battery negative lead. The battery negative lead is to be disconnected. * 

The technician set up the new computer. The new computer was set up by the technician. 

The boy broke the window. The window got broken. * 

Mary crossed the road. The road was crossed by Mary. (!) 

Fill in the form and post it back to us in the 
envelope provided. 

The form is to be filled in and posted back to us in 
the envelope provided. 

Each morning, check that there is enough 
paper in the photocopier.  

Each morning, the photocopier is to be checked to 
see if it has enough paper. * 

Fill the kettle with water. The kettle is to be filled with water. * 

The doctor’s quick action saved John’s life. John’s life was saved by the doctor’s quick action. 

You have not paid the bill. The bill has not been paid. * 

The airline lost their luggage. Their luggage was lost. * 

The programmer will test the new software. The new software will be tested. * 

We have investigated your complaint. Your complaint has been investigated. * 

* Omits to say by whom! 

Use the ACTIVE voice where possible 

ACTIVE sentences make it clear who has to do what. It eliminates ambiguity about 
responsibilities. Not: “It must be done”. But, “You [or someone else] must do it”. Passive sentences 
can sometimes avoid this. 

Example: Memo about cleaning the toilets: 

 
Suppose you arrive at your desk one morning, and you find a memo addressed to you, 
that says: 
 

            “All toilets should be cleaned by nine o’clock every morning.”  
 
You might agree with this completely! But beware: it’s a passive sentence. 
 
What the manager meant to say, using an Active sentence, was: 
 

            “I want you to clean all the toilets by nine o’clock every morning.”  
 
This has quite a different meaning! 
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ACTIVE Style! 

Many sources agree that, for instructional material, use the ACTIVE voice rather than PASSIVE. 
Active implies some action will take place; passive sounds as if it might not. 

The active voice is the “normal” voice that most people use in everyday conversation. Write as 
you would speak to the person. This is the ‘voice’ that we use most of the time. In the active voice, 
the object receives the action of the verb. Hence, “Switch off the light”; “Check the safety lock 
before leaving the premises”. 

The passive voice is less common in normal conversation, but is prominent in “officialise jargon” 
that used to come from bureaucracy, local government, large organisations, and the self-
important. Example: “The light is to be switched off”; “The safety lock is to be checked before 
leaving the premises.” 

Identifying Passive or Active sentences 

What is the difference between passive and active sentences? Grammatically, it is determined by 
the order of SUBJECT, VERB and OBJECT in the sentence. 

ACTIVE 

In an ACTIVE sentence, these three “parts of speech” appear in this order: 

 ACTIVE  =  Subject > Verb > Object 

Active example: “The supervisor (subject) will test (verb) the equipment (object).” 

The SUBJECT is the person, or thing that performs the action. 

The VERB is the ‘doing’ or ‘action’ word. 

The OBJECT is that which is affected by the action. 

Extra words can make the sentence longer, but the same subject > verb > object sequence is 
still in place: 

“The supervisor (subject), who visited the factory last week to overview installation, will 

test (verb) the new equipment (object) on Friday, so that it will be ready for production staff 

to use on Monday.” 

PASSIVE 

Note: ‘Passive’ is not the same as writing in the past tense. 

In a PASSIVE sentence, the order is reversed: 

 PASSIVE:   Object > Verb > Subject 

Passive example: The equipment (object) will be tested (verb) by the supervisor (subject). 

Note: ‘will be tested’ is now passive, and the sentence now includes new words, ‘will be’ and ‘by’. 
These are clues to whether a sentence is active or passive. The feel of the sentence is less 
precise, not so crisp, and a bit clumsy. 
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Haynes Workshop Manuals – ACTIVE sentences 

The popular Haynes Workshop Manuals use ACTIVE sentences almost entirely, throughout, 
and they “talk” directly to the user. For example: 

  

Car Maintenance examples 

“Disconnect and remove the battery.” 

“Remove the air cleaner.” 

“Connect the speedo drive cable.” 

“Release the bellows clips and ...” 

“Lubricate the sliding surfaces ...” 

“Release the front mounting bracket...” 

“Check that the engine mounting is...” 

“Adjust the idle speed to the specified level.” 

“Raise the window glass by hand and ...” 

“Refit the road wheel and lower the car.” 

 
Clue words 1: Because of the way the English language works, there are usually some clue 
words in the sentence. The first clue is that the verb TO BE (am/is/are/was/were/been/be/will be) 
is used with the PAST TENSE FORM of the main verb. Examples: 

was 
were 

will be 
has been 

am 
is 

are 
* became 

* got  

       tested (test) 

   arranged (arrange) 

         made (irregular form of “make”, so not always “ed” ending) 

discovered (discover) 

   recorded (record) 

   compiled (compile) 

*Sometimes other words replace the verb “to be”, such as “got” or “became”. For example – 
“The window got broken”; “The woman became upset by his behaviour”, etc. 
 

Clue words 2: Look for the word “by”. This is another strong clue. Examples: 

 She was amazed by the response. 

 The unit needed calibrating by the manufacturer. 

 

The Passive voice can cause problems because it may not be clear exactly who must carry out 
the action. Or sentences can become too wordy or may sound officious. 
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Writing Instructions for Aerospace 

In the Aerospace industry, they write in a very tightly controlled manner called “ASD
21

 Simplified 
Technical English”. You are not allowed to use a single passive sentence, and you can only use 
words from a defined list. Readability is good, especially for foreign readers, and it reduces 
translation costs – and misunderstandings – significantly. 

The ASD Simplified Technical English specification restricts grammar and style usage.  

 
For example, you need to: 

 Restrict the length of “noun clusters” to no more than 3 words, e.g.  
“Mercedes engine compartment sound insulation” is a cluster of 5 nouns. 
“Core information technology servers” = 4 nouns. 

 Restrict sentence length to no more than 20 words (instructions) or 25 words 
(descriptions); 

 Restrict paragraphs to no more than 6 sentences; 

 Avoid slang and jargon; 

 Make instructions as specific as possible; 

 Use articles such as "a / an" and "the" wherever possible; 

 Use simple verb tenses (past, present, and future); 

 Use active voice for all instructions; 

 Not use -ing participles or gerunds (unless part of a technical name); i.e. avoid words that 
make a noun from a verb, such as tuning, installing, logging in, machining, connecting, 
cleaning etc. Instead, use: tune, install, log in, machine, connect, clean, etc. 

 Write sequential steps as separate sentences; 

 Put conditions (such as “if”, “when”, “after” etc.,) first in warnings and cautions. 

 

When is it OK to use Passive? 

The guideline is to make 80 to 90% of your sentences ACTIVE: the more the better.  

But sometimes it is OK to use passive sentences. 

 When it doesn’t matter who carries out the action: “Security will be improved in the next 
software release.” The focus is on the security of the software – it doesn’t matter who 
improved it. 

 To make something more diplomatic. “The form was not filled in correctly” (passive) is 
friendlier than “You did not fill in the form correctly” (active, but sounds like an accusation). 

 If you do not know who did it: “My car was stolen last night.” 

 To avoid responsibility: “The document was leaked to the press” is passive and allows 
anonymity! If you wrote, “My department leaked the document to the press” this would be 
active and an admission of guilt! 

This Training Manual has about 4% passive sentences, many of which come from the passive 
sentence examples. 

                                                      
21

 AeroSpace and Defence Industries Association of Europe (ASD) based in Brussels 
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Exercise 3 – Write PASSIVE and ACTIVE Sentences 

1. INSTRUCTIONS ARE TO BE WRITTEN about how a cup of tea or coffee is to be made; or a 
similar task may be chosen. PASSIVE SENTENCES are to be used:     Object > Verb > Subject. 

P
A

S
S

IV
E

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. REWRITE THE INSTRUCTIONS and use ACTIVE SENTENCES:     Subject > Verb > Object. 
Assume the reader has to do the task, therefore use a direct instructional approach. 

A
C

T
IV

E
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 Note the difference in the way the information is given. Which of the two is easiest to read 
and understand? Do you notice anything else?  
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 Your Notes:  Write PASSIVE and ACTIVE Sentences  
 
 
 
 
 
 
 

 After you finish the exercise opposite, answer these questions: 
 
1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit?  
 
 
 
 
 
 
 
 
4. Discuss your ideas with somebody else. 
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Exercise 4 – Convert PASSIVE Sentences to ACTIVE 

Here is an example rich in passive sentences.  

The following activities will be conducted in accordance with the Research Management Plan 
(RMP). Data Collection Files (DCFs) may be generated by Data Management (DM) or Research 
staff during the data query process. DCFs may be provided to the Supervisor for resolution at the 
testing site as specified in the Scope of Work and the RMP. If DCFs are provided directly to the 
site by someone other than the Supervisor, the CTL will request that copies of the DCFs be 
provided to the Supervisor. 

The visit timing is to be confirmed with the relevant study site staff, and a confirmation letter is to 
be provided detailing to the investigator what is to be accomplished at the visit, if these details 
were not included in the previous site visit follow-up letter. 

 
Rewrite the procedure using ACTIVE SENTENCES: Subject > Verb > Object 

Before you write anything, please read these instructions: 

1. If it does not say who has to do something, assume the reader has to do the task. 

2. Highlight the passive ‘clue words’, before you convert the sentences.  

3. Ask yourself, “Who has to do what?” and then write the answer. 

4. Use a direct ‘you’ approach. Start with the words shown below: 
 

Conduct the following activities ... 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Note the difference in the way the information is given. Which of the two is easier to read and 
understand? Do you notice anything else? Discuss in a constructive manner. 

(After you’ve finished – see the answer on p. 132) 
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 Your Notes:  Convert PASSIVE Sentences to ACTIVE  

 
 
 
 
 
 
 

 After you finish the exercise opposite, answer these questions: 
 

1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit?  
 
 
 
 
 
 
 
 
4. Discuss your ideas with somebody else. 
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Exercise 5 – Find the Passive Clauses  

This extract comes from a Research Procedure. Try to find all the passive phrases.  

1. Use a highlight pen to mark the passive verbs and any other clue words. You’re not re-
writing it, this is purely an exercise to find them. 

2. After you have finished, mark a cross X  in the right–hand margin beside any passive 

phrase that does not define who has to do the action. If you cannot answer  

the question “Who has to do it?” then mark it X . 

 

Conducting a Supervisory Visit 

A Supervisor must address all activities described below over the course of the study in 
accordance with the Research Management Plan (RMP) or equivalent documentation and 
instructions. However, not all of the activities described in this section may necessarily be 
performed at each interim Supervisory visit.   

– Meet with study site staff and/or Investigator to obtain an overview of study progress and 
any issues since the previous contact, and to identify any issues that require additional site 
training. 

– Ensure that all new and on-going Immediately Reportable Adverse Events (IRAEs) and 
Unanticipated Adverse Device Effects (UADEs) have been documented, reported and 
followed up appropriately. 

– Verify continued acceptability of study site staff and facilities and discuss any planned 
changes. If changes occur, check whether the appropriate RDs are updated. 

– Determine the status and review the time line for completing pending and outstanding issues 
from previous contact(s). 

– Verify compliance with the informed consent procedures and conformance with the required 
subject visit schedule, and confirm whether all study–specific procedures were performed 
after written consent was obtained. 

– Review the accuracy, completeness, and legibility of the CRF entries, DCFs, source 
documents, and other trial–related records against each other, and ensure that any known 
deviations from the protocol are documented. 

– Review the Investigator Site File or equivalent and determine whether the investigator or 
designate is maintaining the RDs, Research Study Documents (RSDs), forms, logs and 
other study documents appropriately. 

– Check whether any changes to data on CRFs were made by authorised study site staff and 
were initialled and dated. 

– Check that the Investigator has verified the accuracy of all DCFs, if applicable. 

– Check that resolved DCFs are filed at the study site. 

– Check whether the Investigator or authorised designate has reviewed all research results, 
including abnormal laboratory results. 

– Inspect the storage conditions of laboratory kits, expiration date and adequacy of supplies. 

– Document and discuss with the Investigator and/or designated staff any issues relating to 
the handling and documentation of IP, including storage conditions, IP records, 
reconciliation, expiration date and adequacy of supplies. 
 

 
(No cheating! – but the answer is on page 134). 

X 
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 Here are the Readability Statistics for this 
extract. 

 

 Passive Sentences = 43%. This is too 
high. Aim for 10% – 20% maximum. 
 

 Reading Ease = 18.4.  
 
This is very bad; confusing. 
  
The score rates text on a 100–point scale;  
a higher readability score is easier to 
understand.  
 
For most standard documents to average 
readers, aim for about 60 to 70. 

 

 
 Your Notes:  Find the Passive Clauses  
 
 
 
 
 
 
 

 After you finish the exercise opposite, answer these questions: 
 
1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit? 
 
 
 
 

How difficult was this example to read and understand? 
 
 
 

 
 
Note: We cover Readability Analysis and Statistics later – see page 102. 
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Writing Style 

First person?  Second person? Third person? 

Personal pronouns: 
First person = I, me, we, us.  Second person = you.  Third person = she, he, it, they. 

Personal pronouns – I, me, my, mine; we, us, our; you, your, and yours – help to achieve a 
conversational tone that is so important to plain English. Use of ‘you’ and ‘we’ involve your reader 
and make a connection that helps keep the reader involved. This also reduces your chances of 
using the passive voice. 

22
 

If you have been to University, then they probably taught you to write in the third person and use 
passive sentences: 

“The temperature was raised gently to 90 ºC and then the valve was closed by the 
technician.” 

– and so on. Also, you were writing a past experience, and that’s how they taught you to write a 
good thesis: you were intentionally showing off your knowledge. 

However, out in the real world, you are trying to teach people how to do something, and some of 
them will know nothing about the subject. Your style must be different, a little more directive; 
therefore talk them through it, step by step. 

 “I”: The first person singular is accepted in scientific writing, but use it sparingly. You 
might want to emphasise things that “you” uniquely did; e.g., “I calibrated the system 
before despatch.” 

 “We”: The first person plural is good for both instructional and report writing.  
 “We replaced the broken assembly...”;   
 “We recommend that you calibrate the system once every three months.” 

 Second person: “You”. As a Technical Writer, you will often be writing instructions 
about how to do something. The second person form, the “you”-oriented style is much 
better;  
e.g.  - “Increase the pressure until it lifts the load off the ground.” 
   - “You must log in before you can use the system.” 

 “He, she, it, they, one; the reader; the user...”: Third person:  
This sounds stuffy and dull. Would a car instruction manual say: 
  “The user should carefully remove the trim panel from under the windows”?  
– or simply: 
 “Carefully remove the trim panel from under the windows.” 
 
Which sounds stuffy? Which sounds clear and easy? 

If one uses his or her brain, then he or 
she can succeed. 

If you use your brain, then you can 
succeed. 

The user clicks the Save button to save 
the file. 

Click the Save button to save the file. 
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 Society of Technical Communicators. 
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Address the reader directly as ‘You’ 

In instructional material, you can usually address the reader directly as ‘you’, whether you actually 
include the word “you” in the sentence or not. See examples in the table below. 

More than any other method, using “you” draws readers into a conversation, rather than making 
them feel “spoken at” from a distance. They feel involved; it becomes relevant to them. This 
means they will understand it better – which is a prime goal of the Technical Writer. 

Haynes Workshop Manuals are an excellent example – they use the ‘you’ approach throughout. 

Examples: 

Before After 

The wire should be connected to the terminal by 
the engineer when the switch-box assembly is 
completed. 

After assembling the switch box, connect the 
wire to the terminal. 

The spring and the shock absorber protective 
shield are to be removed. 

Remove the spring and the shock absorber 
protective shield. 

The user switches the computer on and waits 
for it to boot up. 

Switch on the computer and wait for it to boot 
up. 

Service Notes are available from the company. We can provide you with Service Notes. 

The System Administrator has to look after the 
following areas of responsibility ... 

If you are the System Administrator, you are 
responsible for ... 

The dipstick is removed and the oil level is 
checked. 

Remove the dipstick and check the oil level. 

The driver turns left at the next traffic lights and 
then takes the first turning right. 

Turn left at the next traffic lights and then take 
the first turning left. 

 

Using ‘We’ to refer to your company 

You can nearly always refer to your organisation as ‘we’. 
If necessary, make it clear near the beginning of the 
document.  

For example,  
“At Johnsons, we aim to...” 
“We include all cables and assembly tools...” 
“We will tell you when the system is ...”  

This is more friendly and welcoming to your readers; you 
are including yourselves and your readers in a 
conversation, rather than “talking at them”.  

It’s the way you would probably say it if you were in a 
meeting with them. It also makes your sentences shorter. 

 
Look at this open, honest and friendly message  

from outside caterers, at a company canteen :      
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Target the Reader Groups 

When you write, use appropriate words for the readers. Keep it simple and straightforward, and 
use words that they will understand. 

Think about whom you are talking to. What sort of people are they? What is their age range? 

Older people have more wisdom and experience of life in the workplace, but their IT skills may be 
limited. Young people just out of school/college tend to be highly computer–literate, but their 
experience in the workplace is limited. 

What are their Technical skills? Education? Experience? Computer literacy? Some or all of these 
will determine the best way to ‘talk to’ your target reader groups in the way that you write. 

Example: Suppose you have to write a Report or a Procedure that will be read by three groups of 
people in these categories: Chief Engineers; Commercial; Accounts. 

1:  How would you rate their technical understanding? 

 TTT = very technical 

  TT  = reasonably technical 

   T   = not very technical 

Mark your score in the table below: 
 

How technical are they? Score 

Chief Engineers  

Commercial (sales, negotiators, etc.)  

Accounts (accountants, clerical)  

 
So, how would you make sure they ALL understand it? (Write your answer here) 

 
 

 ......................................................................................................................................................  

 

2:  What if the Commercial and Accounts people only need to read, say, an introductory 
part of the document, but the Chief Engineers will read all of it? 

Why not have different sections? 

Document 

Part 1 – Simple Language for 
             Non-Technical readers T 

 

Part 2 – Moderately Technical TT 

Part 3 – Serious Technical Talk TTT 
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Jargon and Acronyms 

Jargon 

Jargon is the language used by people who work in a particular area or who have a common 
interest: lawyers, computer programmers, scientists, financial services, pharmaceuticals, etc. All 
have specialised terms and expressions that they use, many of which may not be comprehensible 
to the outsider. They may also use familiar words with different meanings as well as abbreviations, 
acronyms etc.

23
 

Only use jargon if all the target readers will understand it. And remember to allow for the new 
member of staff, who may not know the jargon yet – so provide a definition nearby (See 
Footnotes below).

 

Acronyms 

Beware of acronyms – these can be worse than jargon!  

I once did some documentation work in the Pensions industry, where they used 86 acronyms in 
just one pension product. They even talked to each other like it:  
     “Is Mr Jones COMP or CIMP? Has he PUPPED yet?” 

This can be a nightmare for a new member of staff, who can make costly mistakes if they get it 
wrong.

 

Footnote and Glossary 

If you use jargon and acronyms, and you suspect that some readers will not understand, make 
sure you define these terms somewhere within easy reach. 

You might define it in brackets just after the first occurrence of the term on the page, or add it in a 
footnote at the bottom of the page. 

A less-accessible method is to include a Glossary of Terms. This could be either near the front, so 
that they read it before starting on the rest of the document, or at the back in the Appendix. 

Whichever method you use, make sure the reader knows where to find it. 
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 Using English, an educational web site. 
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Exercise 6 – Jargon 

INSTRUCTION 1 – use DIFFICULT TECHNICAL LANGUAGE with lots of JARGON. 

Write a brief Procedure about how to perform a task, or to use a product or service that your 
organisation provides. Make it very technical, but try to avoid acronyms for this exercise. Assume 
that the target reader is familiar with your field of work, has similar education and technical 
expertise, and is a native English speaker.  

J
A

R
G

O
N

 /
 S

U
P

E
R

–
T

E
C

H
N

IC
A

L
  

 
 
 
 
 
 
 
 
 
 
 
 
 

 

INSTRUCTION 2 – REWRITE USING PLAIN ENGLISH 

Now rewrite the instruction in Plain English. Imagine the reader is a Polish employee who joined 
your company one month ago. She has limited knowledge of the subject, but needs to understand 
perfectly what you have written, and get it right first time. She learned English at school up to age 
16. Her verbal English is reasonable, but she has not used written English since ten years ago. 

P
L

A
IN

 E
N

G
L

IS
H

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Note the difference in the way the information is given. Which of the two is easiest to read 
and understand? Do you notice anything else? 
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 Your Notes:  Exercise 6 – Jargon  
 
 
 
 
 
 
 

 After you finish the exercise opposite, answer these questions: 
 
1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit?  
 
 
 
 
 
 
 
 
4. Discuss your ideas with somebody else. 
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Instructions and Procedures 
The reader wants to know what to do. That’s why they are reading the instructions. So tell them! 
Yes, be polite; but people prefer to know exactly what you want them to do – they don’t want to 
make a mistake. 

Simple Stuffy! 

Please use the checklist. It is recommended that it would be better to use the checklist. 

Hush! The audience is requested to be quiet. 

Wash your face. Children are advised that their faces should be washed. 

Please be careful to ... Users are cautioned that they should be careful to ... 

 

 

Noun or Verb? 

If you want to keep the reader’s interest, then use the active verb form rather than  
the noun derived from it, known as a “nominalisation”. For example: 

Noun form   Active Verb  
                    

Noun form   Active  Verb  

abbreviation abbreviate  education educate 

affirmation affirm  explanation explain 

attention attend  imitation imitate 

collection collect  introduction introduce 

confirmation confirm  persuasion persuade 

construction construct  production produce 

digression digress  publication publish 

division divide  revision revise 

The noun form is an abstract object, instead of an action; it sounds dull and inactive. 

 Are there any that you use fairly often? If so, highlight them to remind yourself to try the 
verb form.  

Here are some example sentences. Note that the active verb form is shorter, simpler, and sounds 
more as if something will actually happen: 
 

Active verb form  Noun form  

We will attend to this immediately. We will give this our immediate attention. 

ABC Builders will construct the offices. ABC Builders will carry out the construction of 
the offices.  

The Training Officer will instruct the staff on 
safety issues. 

The Training Officer will give instruction to the 
staff on safety issues. 

The next step is to persuade the user to ... The next step is persuasion of the user to ... 

... which complies with...  ... in compliance with ... 

Imagine how they would sound if somebody spoke these words to you.  
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Bullet Point lists and Punctuation 
Bullet points help to make a list of items, instructions, etc., very clear to the reader. 

For a simple list of items, write it like this, with no punctuation except for a full stop at the end of 
the last item: 

Allow for ceiling fittings, such as: 

 fluorescent light fittings 

 down lighters 

 sprinklers 

 smoke detectors 

 security cameras, etc. 

 
For longer statements that are not separate sentences, use a semicolon after each point and use 
a lower case letter to start each line: 

Before you move the machine, check that: 

 you have disconnected all hoses and cables; 

 you have cleared the floor of obstructions; 

 you have another person with you to help. 

 
If the bullet points are each separate and complete sentences, end each with a full stop. See 
below. 

This is a very clear example of the difference that bullet points can make. It is a real-life example 
of a cluttered, long sentence, re-written using bullet points: 

BEFORE 

A postcode field can be linked to an external product such as “Quick Address Pro” 
(“Quick Address Pro” allows the entry of a postcode and will automatically complete 
the address fields, the house number can be selected from a list) or “Rapid” from QAS 
Systems (Quick address “Rapid” allows the entry of a postcode and will automatically 
complete the address fields) or “AFD Postcode” from Nildram Software (“AFD 
Postcode” allows the entry of a postcode and will also automatically complete the 
address fields. 

(Reading ease = 0!) 

83 
words! 

AFTER 

A postcode field can be linked to an external product such as: 

 “Quick Address Pro”. This allows the entry of a postcode, and will 
automatically complete the address fields. The house number can be selected 
from a list. 

 “Rapid” from QAS Systems. This allows the entry of a postcode, and will 
automatically complete the address fields. 

 “AFD Postcode” from Nildram Software. This also allows the entry of a 
postcode, and will automatically complete the address fields. 

(Reading ease = 60) 

U
s
e
 b

u
ll

e
t 

p
o

in
ts

 t
o

 
 m

a
k
e
 t

h
is

 e
a
s
ie

r 
to

 u
n

d
e
rs

ta
n

d
. 

 
This simple rearrangement makes a huge difference to readability. 
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Bullet Points for Instructions 

Use bullet points when listing step-by-step instructions. This helps to emphasise each step. 

Introduce the list with narrative text first. Use an initial capital letter, and a full stop after each 
sentence. Here is an example: 
 
 

This topic tells you how to change paper in the photocopier: 

 Pull out the paper tray at the bottom of the copier. The display indicates 
“No Paper”. 

 Put new paper into the tray, but do not fill above the black arrow marks 
either side. 

 Make sure the paper is settled into place, and then replace the paper tray 
into the copier. The display should then indicate “Ready”. 

 
Numbered Lists 

I once edited some business instructions that went to more than 150 steps. When I reached step 
117, I was starting to sag, and thought, “How long does this procedure go on for?!” 

Numbered lists just give the reader’s mind extra information to process and discard. Often, it is just 
clutter and doesn’t need to be there. Only use numbering if there is a business reason to do so. 

Instead, try to use subheadings to break the content into blocks of instructions, and within each 
block use a series of up to five or six bullet point instructions. 

Documentation of a legal nature often needs to refer to paragraph numbers, which is therefore OK. 

Numbering to emphasise a sequence 

Sometimes it helps to use numbers to emphasise when the user must do things in a certain order. 

See an example of an image annotated with numbers, and the related numbered instructions, on 
page 120. 
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Exercise 7 – Bullet Points 

Write a short technical instruction on how to do a common task. This is an exercise in layout 
and making instructions easy to follow. This can be real or imaginary. Here are some ideas. 

 How to lay a table for a meal. 

 How to repair a puncture in a bicycle tyre. 

 How to set up a piece of equipment (of your own choice) before use. 

 How to change a wheel on a car. 

 Anything else. 

1: Write One Continuous Paragraph. 

C
O

N
T

IN
U

O
U

S
 P

A
R

A
G

R
A

P
H

 

 
 
 
 
 
 
 
 
 
 
 
 

2: Rewrite using bullet points to separate the steps 

B
U

L
L

E
T

 P
O

IN
T

S
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you have finished, swap your work with somebody else. 

 Check each other’s grammar, spelling and punctuation. Circle anything you would 
question. 

 Note the difference in the way the information is given. Which of the two is easiest to read 
and understand? Do you notice anything else? 

 How has your partner handled jargon and abbreviations? Would a non-technical reader 
understand it? 

 Discuss your observations with each other, in a constructive manner. 
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Changes in English Grammar  
The English language has evolved since many of the rigid rules of grammar were first invented, 
some of them centuries ago. So let’s update the situation. 

Beginning of a sentence 

It’s OK to start a sentence with conjunctions or prepositions such as And, But, So etc. Use them 
for emphasis. Some of the best writers have been ignoring this rule for years. And why not? 
But some people persist in prohibiting this technique. Yet we defy them. Or we simply ignore 
them. Nor do they understand our attitude, though we try to convince them, and will continue to do 
so. So there.   

24
 

But don’t do it too much – it can be a distraction. Use the rules as a guideline, but ignore them if 
you need emphasis. 

End–of–sentence Prepositions 

There are over 100 prepositions in the English language. Here is a selection: 

 
aboard about above across after against along 
among around at athwart atop before behind 
below beneath beside besides between beyond but 
by down during except for from in 
inside into like near next of off 
on onto opposite out outside over plus 
round since than through throughout to toward 
towards under underneath unlike until up upon 
with within without 
 

 
Many people have heard of the 'rule' that says that a sentence should never end with a 
preposition. This public school doctrine was based on Latin grammar, so it was considered 
incorrect in English too. There is no justification for it these days, so you can safely ignore it.  

25
 

Put the preposition where it sounds natural. For example: 

“These people have no idea what they are talking about.” 

“Have you found that report you were looking for?” 

“What are you looking at?” 

“The sump fixes underneath.” 

“John was good company to travel with.” 

“What country do you come from?” 

“Am I getting my point across?” 
 

 

Here is a much–quoted story: 
 

About 50 years ago, an editor once rearranged one of Winston Churchill‘s 
sentences to avoid it ending with a preposition, and sent it back to him.  

The Prime Minister, very proud of his style, scribbled this note in reply: 
 

“This is the sort of b****y nonsense up with which I will not put!” 26
 

                                                      
24

 www.dailywritingtips.com  
25

 Hutchinson Encyclopaedia and many other references. 
26

 Oxford Companion to the English Language. 
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Spelling Does Matter! 
Bad spelling loses business! However, the brain can do wonders with the odd mistake here and 
there. Look at this example: 
 

“I cdnuolt blveiee taht I cluod acutlaly uesdnatnrd waht I was 
rdanieg. The phaonmneal pweor of the hmuan mnid! Aoccdrnig 
to a rseaerch at Cmabrigde Uinervtisy, it deson’t mttaer in waht 
oredr the ltteers in a wrod are, the olny iprmoatnt tihng is taht 
the frist and lsat ltteer be in the rghit pclae. The rset can be a 
taotl mses and you can sitll raed it wouthit a porbelm. Tihs is 
bcuseae the huamn mnid deos not raed ervey lteter by istlef, 
but the wrod as a wlohe. Amzanig huh?” 

 
OK, that’s just for fun. 

We all make spelling mistakes at times, but it does not impress the 
reader...   

SPELLING REALLY DOES MATTER! 

           
  Good grief!   Wrong!           Wrong! 

 

 
Wrong! 

Mistakes look bad and unprofessional. If there are too many of them, the reader might wonder if 
they should be dealing with a different company. 

   As you know, don’t rely completely on the spell checker in the word processor. If you mis-
spell a word and it makes another valid word, then the spell checker ignore it. 

Bad English: National Opinion Poll Survey 

 
Many businesses suffer from the style of their written output, with ideas poorly expressed, 
confusing to the reader, bad grammar, bad design, and so on.  
 
A National Opinion Poll survey in 2005 concluded: 

“Bad design, poor grammar and atrocious spelling could be costing UK 
businesses a staggering £41 billion a year in lost sales. 

74% of customers said they wouldn’t trust businesses that used poor spelling or 
grammar, whilst 30% said they wouldn’t buy any product or service from them.” 
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Using the Correct Words 

Some common misunderstandings 

“which” or “that” ?  

 that   DEFINES or RESTRICTS –  e.g., 
“The lawn mower that is broken is in the 
shed.” 
Implies that there may be another, but that 
one in the shed is broken. 

   

 which    gives extra, non-essential 
information; e.g., 
“The lawn mower, which is broken, is in the 
shed.” 
This implies there is only one lawn mower. It 
is broken, and you’ll find it in the shed. 

 

Utilise or Use ?  

 Utilise is not the same as use. It means, “to use something in an effective way” 
27

, 
or “to make best use of”. 
 
Example: “He utilised the space available by fitting shelves.” 

Principal or Principle ?  

These two words sound the same, but have different meanings.  

 Principle is a noun, and it means a fundamental truth, a scientific theorem.  
– “It’s the principle that matters.” 
– “That’s a good idea, in principle.” 
– “These machines all operate on the same principle.” 
– “... the principles of democracy...”. 
 

 Principal (think of a for adjective, means the “main or most important”, as in 
– “one of the country’s principal cities”; 

 Principal as a noun means the senior person, as in “The principal of the college”. (To help 
you remember, he’s your pal.) 

-ise and –ice word endings  

 Use -ice for nouns (music practice; I need some advice; also – driving licence),  

 Use -ise for verbs (I practise the piano; she advised me to exercise more; he was licensed to 
sell alcohol). 

Exception: “exercise” is the spelling for both the noun and the verb. 

Login or Log in ?  

 Login – is an adjective, a describing word; as in: “Login screen”. 

 Log in – is the verb form: “Log in and open the required file.” 

Hence make the button  and not . 

                                                      
27

 Cambridge Advanced Learner's Dictionary. 



 1 – HOW TO WRITE GOOD DOCUMENTATION 

 

Professional Technical Writing Course, to be distributed Free of Charge. Copyright © 2018 Philip Tory, Technical Author, UK 41 
 

Meaningless Text 

Eliminate words that do not add meaning, that are mere padding.  
They waste space on the page, and the reader has to filter them  
out before they can focus on the real message. 

For example: 

Instead of ... ... try ... 

a number of  several 

adding together  adding 

adequate number of enough 

as a matter of fact in fact (or omit)      

at regular intervals of time regularly 

cancel out  cancel 

conduct an investigation investigate 

despite the fact that even though 

during the course of    during 

for the purpose of  for 

I would appreciate it if you would...      Please... 

in the majority of instances usually 

in view of the fact  given (or omit) 

in view of the fact that  because 

it can be seen that  (omit) 

it is a fact that  (omit) 

it would appear that apparently 

on a monthly basis monthly 

owing to the fact that because 

shows a preference for prefers 

sufficient number of enough 

the vast majority  most 

whether or not  whether        

 

 

 



PROFESSIONAL TECHNICAL WRITING   
 

42 Professional Technical Writing Course, to be distributed Free of Charge. Copyright © 2018 Philip Tory, Technical Author, UK 
 

Word alternatives 

Try using the shorter and simpler words on the right: 

 Use your highlight pen to mark those that might be useful… 
 

Instead of ... ... try ... 

additional  extra  
advise  tell  
are able to can 
at such time as when 
at this precise moment in time now 
by reason of because 
commence begin / start 
commencement start / beginning 
complete (the form) fill in  
concur agree 
consequently  so  
do not hesitate to please 
due to the fact that because 
during such time as while 
during the course of during 
employ (meaning to use) use 
for the duration of during 
for the reason that because 
forthwith immediately 
forward  send  
henceforth in future 
I am in receipt of I have 
in case if 
in excess  of  more  than  
in order to to 
in the event of  if  
instantaneously instantly 
is able to can 
is applicable applies 
is unable to cannot 
is under obligation to must 
member of the board of directors director 
on request  if you ask  
owing to the situation that because, since 
particulars  details  
per an  num  a year  
pers ons  people  
prio r to (the occasion when) before  
purcha se buy 
regar ding  about   
should a situation arise where  if  
subsequent to after 
unaware of the fact didn’t know 
taking into consideration such factors as considering 
there is a reasonable expectation that probably 
with immediate effect immediately 
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Accuracy of Meaning 

English is a strange language, rich in colloquial expressions and ambiguous words. Here is a 
trivial example to illustrate a point. 

 
He made arrows and a bow from a bough of a tree. She brought a bow for his violin. He bowed his 
violin, bowed to his master and walked to the bow of the ship. With ribbon, she tied a bow in her 
hair. 
 

 
And a few more, just for fun: 

Farmers produce produce abundantly. 

Is it possible to desert someone in the desert while eating a dessert? 

You can tune a piano, but you can’t tuna fish. 

 

As Technical Writers, we must be clear and unambiguous when we write – we will not be there 
with the reader to correct mistakes. Some English words are imprecise and ambiguous, so we 
must be careful when we use them; and in some cases, avoid them completely! Only you can 
judge whether you really mean what you say. Lack of punctuation can change the meaning, too. 

Word Order  

Look at this headline from an advertisement in the Daily Mail newspaper, in February 2006: 
 

FREE SUMMER FLOWERING PLANTS 

FOR EVERY READER WORTH OVER £30 

 

( This begs the question, “What if the reader is worth only £10?”...    ) 

 

What should it say? What would be the correct wording? 
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English as a Foreign Language? 

About ONE BILLION people in the world speak English 
as a foreign language, according to the British Council. 

Comprehension is more difficult when your readers’ first language is not English. 

(a) They may only remember conversational English from secondary school, and therefore 
find written English much harder. You can help them if you write in a conversational style – 
just talk them through the procedure that you want them to do. 

(b) Some words do not translate well because of the context; they translate into different 
words in the other language. 

(c) Some words in English are both a Verb and a Noun. The translator may have to guess 
which it is, based on the context. 
 
For example, consider the word “Oil”. As a verb, it means ‘to lubricate’; as a noun, it means 
‘lubricant’. Therefore, try to use the correct, unambiguous word. 
 
Another example: a sub heading in a procedure says ‘Document Visit’. Does this mean that it 
is a visit to look at documents? Or does it mean that you must ‘Document the Visit’? Or is it 
about ‘Documenting the Visit’? 

Choice of Vocabulary 

Therefore, be careful to use words that have literal meaning rather than idiomatic meaning. 

For example, in 1989, a China Airlines flight, flying in zero visibility, crashed into the side of a 
mountain shortly after take-off. On the voice recorder, the last words of the Chinese pilot to 
the co-pilot were, “What does ‘pull up’ mean?” 

28
 

The official term used in “control tower” talk is climb. However, the warning system built into 
the US-made planes gives an audible warning: “Pull up! – Pull up!” if altitude drops, or an 
obstruction looms ahead. 
 
Ambiguity leads to mistranslation and misunderstanding, or worse. 

Idiomatic Expressions 

Some phrases are unique to a language, and would not make sense if translated literally. Look at 
these examples of English idiomatic expressions and their French equivalents: 

English phrase French equivalent and its direct translation 

I feel a little under the weather. I don’t feel in my plate. 
(Je ne me sens pas dans mon assiette.) 

He’s as cool as a cucumber. He is of Olympic calm. 
(Il est d’un calme olympien.) 

They are barking up the wrong tree. They are taking the wrong road. 
(Ils font fausse route.) 

They are pulling our leg. They are making us walk. 
(Ils nous font marcher.) 

Pigs might fly before that happens. It will happen when chickens have teeth.  
(Ça arrivera quand les poules auront des dents.) 

Some phrases do translate as written: for example, to “sweep it under the carpet” translates 
directly into German as “Unter dem teppich kehren” – exactly the same idiom. 

                                                      
28

 ‘Technical Communication’, A Study of Plain English Vocabulary and International Audiences: Aviation 
English Classes. Vol 48, Number 3, August 2001. 
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Exercise 8 – Writing for non-English speakers 

Idiomatic expressions do not translate well (if at all) into another language. This is a problem for 
readers for whom English is not their first language, and also a problem when translating.  
This exercise is to help you think about the way you write.  Rewrite some of these examples: 

Example idiomatic expression  Rewrite the underlined phrases in good English 

1. I’m not with you.  To us, this means “I don’t understand what you 
said”. However, in real life, a Japanese 
businessman translated it literally and thought it was 
personal rejection: “I want nothing to do with you”. 

2. Engineers must not be kept in the 
dark about safety issues.  

 

3. The new design threw the baby out 
with the bath water. 

 

4. The new software was of mind–
boggling complexity. 

 

5. Although they fixed the main 
problem, the side issues were swept 
under the carpet. 

 

6. You can piggyback this experiment 
with the first one.  

 

7. If you don’t install the system 
correctly, it could cost you an arm 
and a leg in litigation. 

 

8. Keep an eye on the temperature 
gauge while you increase the engine 
speed.  

 

9. The investigation was dogged by 
delays, but we went the extra mile, 
stuck to our guns, and cracked the 
problem. 

 

10. If you want to get the best out of the 
new system, you’ve got to think 
outside the box. 

 

11.  Check that the new installation is up 
to scratch. 

 

12.  It was time to roll out the new 
software. 

 

13.  We put our heads together and 
came up with a solution. 

 

14.  We decided it was time to get our 

act together * 
* 

* Expressions such as, “pull our finger out / get a move on / get our backsides in gear / pull our socks up / 
sort it out / get cracking, are all idiomatic expressions, so they are not valid! 
 

Questions 

 How difficult was it to translate? Why? 

 Why do people use idioms?  
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Weak, Vague and Imprecise Words – Beware! 

Weak words: Should 

Beware the word “should” – it can sound like an option: 
“You should, really, but it doesn’t matter if you don’t”. 

If you mean, “You must…”, then it’s OK to say so. Here are some variations: 
“You must sign the form and post it back to us immediately.” 
“Sign the form and post it back to us immediately.” 
“Please sign the form and post it back to us immediately.” 

These are clear and unambiguous. If you need to be extra polite, add the word ‘please’. 

If ‘should’ means it is optional, then say so, and give them the information to help their decision. 
For example, “Optional: Enter the address if you want this to appear in the usage report.” 

Look at these examples of words that require special care. 

Word Example Comment 

Should “The Supervisor should discuss 
the local process with each 
investigator...” 

It sounds optional; “You should, but it doesn’t 
really matter if you don’t.” The word has many 
meanings: 

should (DUTY) 
should (WOULD) 
should (PROBABLE) 
should (ADVISE) 
should (POSSIBILITY) 
should (REASON) 
should (SURPRISE) 

If you must, then say so; be firm, clear and 
unambiguous. 

“The Supervisor must discuss the local process 
with each investigator...” 

How to avoid “Should” 

Sometimes you can change “should” to “must”, otherwise just write it another way... 

Before After 

The member should be made aware... Tell the member... 

The file and quotation should now be passed to 
an authorised checker. 

Pass the file and quotation to an 
authorised checker. 

This should be pointed out to the consultant. Point this out to the consultant. 

Details should be sent in writing... Send details in writing... 

You should send... Send... 

... you should still obtain an up-to-date figure ... you must still obtain an up-to-date figure 

The client should be advised... Advise the client... 

The member should use the certificate... The member must use the certificate... 

The following message should appear at the 
bottom of the Menu screen... 

(You can probably leave this as it is. 
The message should appear, but you 
never can tell, with software!) 
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Other weak words 

May “Work may not be 
initiated without 
management approval.” 

“May” sounds optional, depending on context. “It may, but 
it doesn’t have to”. The word has different meanings: 

may (POSSIBILITY) 
may (PERMISSION) 
may (WISH) 

If it must, or must not, then say so: “Work must not be 
initiated without management approval.” 

However, it is correct to say: “Management has the power 
to decide whether the research may take place or not.” 

Shall “The Supervisor shall 
check that the sites 
comply with...” 

In translation to another language, the distinction between 
the imperative (“shall check”) and the future tense (“will 
check”) is not clear. The sentence structure may be new 
to the reader unless they learned it thoroughly at school. 
The word has different contexts: 

shall (FUTURE) 
shall (SUGGEST) 
shall (CERTAINLY WILL) 

Again, if you must then you must. 

“The Supervisor must check that the sites comply with...” 

Note: In contractual or legal documentation, or technical 
specifications, you can use “shall” for the imperative, 
instead of “must”. 

Would “... an advisor to the 
NHS institutions where 
the research would take 
place.” 

This word is not precise and does not translate clearly into 
other languages. What is its exact meaning? – the word 
has many contexts: 

would (FUTURE) would (OPINION) 
would (INTENTION) would (LIKELY) 
would (POSSIBLE) would (ADVISE) 
would (REQUEST) would (WILLING) 
would (WISH) would (REASON) 
would (OFTEN) 

If you mean the future tense, then use it: “... an advisor to 
the NHS institutions where the research will take place.” 
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Get “Get this!” “Get” is one of the worst offenders in the English language, so try to 
avoid it unless you are certain the person will understand.  

Only a skilled English speaker understands these immediately:  
“get at”, “get from”, “get over”, “get round”, “get through”, “get by”, 
“get going”. 

Here is a sample of just 54 of over 250 different expressions and 
uses. 

get (ANNOY) get (BE) 
get (BECOME ILL WITH) get (BECOME) 
get (CAUSE) get (CONFUSE) 
get (DEAL WITH) get (EMOTION) 
get (HAVE CHANCE) get (HIT) 
get (LOOK AT) get (MOVE) 
get (OBTAIN) get (PREPARE) 
get (REACH) 
get at somebody (CRITICISE) 
get at somebody (INFLUENCE) 
get at something (REACH) 
get at something (SUGGEST) 
get away with something (AVOID PUNISHMENT) 
get away with something (SUCCEED) 
get out (BECOME KNOWN) 
get out (LEAVE) 
get out (VISIT PLACES) 
get out of something (AVOID) 
get out of something (STOP) 
get round (somewhere) (NEWS) 
get round somebody (PERSUADE) 
get round something (AVOID) 
get somebody back (ACT UNPLEASANTLY) 
get somebody down (MAKE UNHAPPY) 
get somebody in (EMPLOY) 
get somebody up (DRESS) 
get something back (BE GIVEN) 
get something down (SWALLOW) 
get something down (WRITE) 
get something in (BUY) 
get something in (FIND TIME) 
get something in (SAY) 
get something in (SEND) 
get something off (POST) 
get something off (something) (REMOVE) 
get something out of somebody (PERSUADE) 
get something out of something (ENJOY) 
get something up (ORGANISE) 
get through (TELEPHONE) 
get through something (EXAM) 
get through something (FINISH) 
get to somebody (UPSET) 
get together (MEET) 
get together (START) 
get up (STAND) 
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Gobbledegook – some examples 

The Small Print... 

“All transactions effected pursuant to this instrument shall be effected for the account and risk and 
in the name of the undersigned; and the undersigned hereby agrees to indemnify and hold you 
harmless from, and to pay you promptly on demand, any and all losses arising therefrom or any 
debit balance due thereon.” 

29
 

[i.e. “You’ll be responsible for anything you owe on your account.”] 

 

Department for Culture, Media and Sport 

“Food or drink supplied on or from any premises is ‘hot’ for the purposes of this Schedule if the 
food or drink, or any part of it — 

(a) before it is supplied, is heated on the premises or elsewhere for the purpose of enabling it to be 
consumed at a temperature above the ambient air temperature and, at the time of supply, is above 
that temperature, or 

(b) after it is supplied, may be heated on the premises for the purpose of enabling it to be 
consumed at a temperature above the ambient air temperature.” 

30
 

 

Central Manchester and Manchester Children’s University Hospitals NHS Trust 

From an Agenda for Change document: 

‘Where the combined value of the above payments before actual assimilation remains greater than 
the combined value of the payments after assimilation, the former level of pay will be protected. 
These protection arrangements apply to the combined value of payments before and after 
assimilation, not to individual pay components, excepting the provision relating to retention of 
existing on–call arrangements.’ 

31
 

 

From a B2B Links web site: 

“Junkk.com is a brand new, commercially–oriented, Internet–based environmental awareness 
business venture. Its core mechanism is a web–based, interactive recycling–ideas database 
created by and freely accessible to the general public, with the complementary participation and 
support of environmentally aware blue–chip retailers and manufacturers, as well as 
media/marketing savvy SMEs and local authorities. If you think you can help us or you’re 
interested in finding out more information then check the Website out, or contact us!” 

 

More Mangled English  

“Reports that say something hasn’t happened are always interesting to me because, as we know, 
there are known knowns; there are things we know we know. We also know there are known 
unknowns; that is to say there are some things we do not know. But there are also unknown 
unknowns - the ones we don’t know we don’t know.” – US Defence Secretary, Donald Rumsfeld 

32
 

 
“Our enemies are innovative and resourceful and so are we. They never stop thinking about new 
ways to harm our country and our people, and neither do we.” – George Bush. 

33
 

 
“I never knew I didn’t have that much petrol” – anon. 

                                                      
29

 BizAlert Blog 
30

 UK Laws - Licensing Act 2003 (c.17) 
31

 About.com, an educational site about Grammar and Composition 
32

 The Maitland Mercury, Australia, 10 Dec 2003. 
33

 Herald Sun, Australia, March 2010. 
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“Brevity” – Churchill’s Memo to the Cabinet 
Look for the business reasons behind Winston’s recommendations: 

 
 

 

“To do our work, we all have to read a mass of papers. Nearly all of them are far too long. 
This wastes time, while energy has to be spent in looking for the essential points. 

I ask my colleagues and their staff to see to it that their reports are shorter. 

The aim should be reports which set out the main points in a series of short, crisp 
paragraphs. 

If a report relies on detailed analysis of some complicated factors, or on statistics, these 
should be set out in an appendix. 

Often the occasion is best met by submitting not a full-dress report, but an aide-memoire 
consisting of headings only, which can be expanded orally if needed. 

Let us have an end of such phrases as these: 

‘It is also of importance to bear in mind the following considerations’, 

or 

‘Consideration should be given to the possibility of carrying into effect’. 

Most of these woolly phrases are mere padding, which can be left out altogether, or 
replaced by a single word. Let us not shrink from using the short expressive phrase, even 
if it is conversational. 

Reports drawn up on the lines I propose may first seem rough as compared with the flat 
surface of officialese jargon. But the saving in time will be great, while the discipline of 
setting out the real points concisely will prove an aid to clearer thinking.”       34 

Winston Churchill 

 

                                                      

34
 Quoted widely by many different sources. 
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Simplify! 
Sometimes we write too much meaning into one sentence, and confuse the reader. 
 

Example 1 

The following descriptions have roughly the same content and meaning: 
35

 

1. The original sentence 

“With the cover removed, tighten the screw using a hexagonal key while holding the nut with a 
spanner before replacing the cover.” 
 

2. Separate the ideas 

“While the cover is not fitted, tighten the screw using a hexagonal key while holding the nut with a 
spanner. Refit the cover.” 
 

3. Final version with clear style 

 Remove the cover. 

 Use a spanner to hold the nut, and tighten the screw with a hexagonal key. 

 Refit the cover. 

 

Example 2 – More information than necessary 

“Most of the natural gas used in the United States comes from domestic gas production. The 
remainder comes from imports, primarily from Canada. Domestic gas production and imported gas 
are usually more than enough to satisfy customer needs during the summer, allowing a portion of 
supplies to be placed into storage facilities for withdrawal in the winter, when the additional 
requirements for space heating cause total demand to exceed production and import 
capabilities.” 

36
 

 

Simplified version 

“Most of the natural gas used in the United States comes from domestic gas production. The 
remainder comes from imports, primarily from Canada.” 

 

 

 

                                                      
35

 The new language in International Business: Simplified English, 2
nd

 Edition. Published by Tedopres 
International BV. 
36

 Energy Information Administration Brochure, Official Energy Statistics from the US Government 
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Exercise 9 – SIMPLIFY!  

Write a new Safety Leaflet in Plain English 

1. FOCUS: First, read all of it carefully. What are the main issues here? 

2. Then, with your highlight pen, mark 4 or 5 key words that are the focus of the message.  

SIMPLIFY: Write a new version below in Plain English. About 60% is padding, so simplify it, 
and use bullet points. 

‘Certain of the components comprising our electrical appliances have inherent 
characteristics the effect of which, whether before or after such components  
have been introduced into appliances or during such introduction, make it  
desirable, in the interests of safety, for the introduction of spare components  
into, and/or the repair of, our appliances to be carried out by a competent  
person. The parts now supplied are done so on the clear understanding that such 
introduction and/or repair will not be otherwise interfered with beyond the extent of normal 
cleaning as recommended in the operating instructions, and that no liability attaches to 
ABC Electrical Appliances Limited for any damage or personal injury from such 
introduction and/or repair.’ 

(117 words, Passive sentences 100%, Reading Ease = 0) 

(From a Safety Leaflet supplied with a spare part for household appliance; e.g. a washing machine motor. 

 Company name changed to protect the guilty!) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you finish, swap your worksheet with someone else. 

 Check their translations. 

 Do you agree? Did they miss any main points? Or did they invent something that was not 
in the original? Why are they not valid? Discuss. 

(After you’ve finished – see the answer on p. 136)
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Exercise 10 – Translate into Plain English (2) 

 

WARD PHILOSOPHY 

“To improve the quality of life in a caring, safe and secure environment with self-care encouraged 
and, although involving an element of risk, with as little disruption to the patient’s own daily routine 
as possible. 

To achieve this goal a good nurse/patient relationship is encouraged with individualised care plans 
enabling staff to highlight specific problems and needs. 

The learners should be made aware of the condition, problems and requirements specific to the 
speciality to enable them to assist safely in the care of patients and complete care plans with 
confidence. 

The overall ward atmosphere should be such that patients are able to relax and be as free of 
anxieties as possible. The learners should be involved in the ward management within their 
limitations – thus forming an essential part of the ward team. 
 

(Passive sentences 20%, Reading Ease = 41) 

Notice on a wall next to a ward reception desk, at a major General Hospital, Feb 2005. 

(“Learners” refers to staff undergoing training – I had to ask!) 

How would you write it? 

 Begin with “We aim to ...” 

We aim to ... 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you finish, swap your worksheet with someone else. 

 Check their translations. 

 Do you agree? Did they miss any main points? Did they create anything that really was 
not in the original? Why are they not valid? Discuss 
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Readability Improvement Examples – BEFORE 
[Ten long sentences taken at random, from example procedures on testing products.] 

1.  Review the accuracy, completeness, and legibility of the CRF entries, DCFs, source 
documents, and other trial-related records against each other, and ensure that any known 
deviations from the protocol are documented (Work Instruction TP027, Development and 
Implementation of Source Data Verification Procedures, and Form TP003 Study Site 
Monitoring Visit Report). 

2. Testing Team Leader or designate (TTL): Develops the Testing Management Plan (TMP) 
(Operating Procedure TP010, Testing Management Plan), defines the Data Query process, 
co-ordinates the monitoring activities of the Monitor, including development and distribution of 
monitoring guidelines, and review of the associated site visit report. 

3. Document and discuss with the Investigator and/or designated staff any issues relating to the 
handling and documentation of IP, including storage conditions, IP records, reconciliation, 
expiration date and adequacy of supplies (Operating Procedure TP004, Investigational 
Product(s)). 

4. A Contact Report (Form TP011, Contact Report) or equivalent may be used to document one 
individual telephone contact or a Telephone Report Log (Form TP017, Telephone Report Log) 
or equivalent may be used to document several telephone contacts on the one form for the 
same site. 

5. Complete a Contact Report (Form TP011, Contact Report) rather than a Site Visit Report to 
document brief visits to sites for a limited purpose (for example, delivery of supplies; collection 
of pre-packaged shipment or outstanding document(s)). 

6. Review the Investigator Site File (TP020 Investigator’s Site File) or equivalent and determine 
whether the investigator or designate is maintaining the RDs, Testing Study Documents 
(TSDs), forms, logs and other study documents appropriately. 

7. Confirm the visit timing with the relevant study site staff, and provide a confirmation letter 
detailing what is to be accomplished at the visit to the investigator, if these details were not 
included in the previous site visit follow-up letter. 

8. If original CRFs have been submitted to data management, document new queries raised by 
the testing staff on a blank Testing Site Data Clarification Form (Template TP013, Testing 
Data Clarification Form) or equivalent approved format. 

9. Complete the applicable Site Visit Report (Form TP003 Study Site Monitoring Visit Report) 
and submit to the TTL for review in accordance with the TMP and Work Instruction TP026, 
Site Visit Reports and Follow-up Letters 

10. Follow up on any pending financial issues including payment to Investigator/site in 
accordance with the Testing Trial Agreement, if applicable (Refer to Work Instruction TP009, 
Preparation of Testing Trial Agreements).  
 

Analysis Passive sentences = 40% against a target of 10-20%. Too high. 
 
Reading Ease 3.8 = very bad, far too low. Higher is better: aim for 60-70 as a target. 
 
Considering the education level of the target readership (all graduates or above), this 
would probably be OK with native English speakers. However, what about those 
whose first language is not English?   
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Readability Improvement Examples – AFTER 

I have rewritten these examples. I have replaced some long words with shorter ones; split long 
sentences; and converted passive sentences into active. There is now more “white space”. 

Readability is improved, and foreign users will translate and understand them more clearly. 

 

1. Check the accuracy, completeness, and legibility of: 

 CRF entries 

 DCFs 

 source documents 

 other trial-related records 

– and check them against each other. 

You must document all known deviations from the protocol. See: 

 Work Instruction TP027, Development and Implementation of Source Data Verification 
Procedures; 

 Form TP003, Study Site Monitoring Visit Report. 

 

2. The Testing Team Leader (TTL) or designate: 

 Develops the Testing Management Plan (TMP). (See Operating Procedure TP010, 
Testing Management Plan.) 

 Defines the Data Query process. 

 Coordinates the monitoring activities of the Monitor. This includes: 

 development and distribution of the monitoring guidelines; 

 review of the associated site visit report. 

 

3. Document and discuss with the Investigator and/or designated staff, any issues about the 
handling and documentation of IP. Include: 

 Storage conditions 

 IP records 

 Reconciliation 

 Expiry date 

 Adequacy of supplies. 

See Operating Procedure TP004, Investigational Product(s). 

 

4. To document a single telephone contact, use a Contact Report. Use Form TP011, Contact 
Report, or similar. 

To document several telephone contacts for one site on one form, use a Telephone Report 
Log. Use Form TP017, Telephone Report Log, or similar. 

 

5. If you make a brief visit to a site for a limited purpose, such as to:  

 deliver supplies; 

 collect a pre-packaged shipment or outstanding document(s); 

– then fill in a Contact Report (Form TP011, Contact Report), not a Site Visit Report. 
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6. Review the Investigator Site File (TP020 Investigator’s Site File) or similar. Check that the 
investigator or designate correctly maintains: 

 RDs 

 Testing Study Documents (TSDs) 

 Forms 

 Logs 

 Other study documents. 

 

7. Confirm the time of the visit with the relevant staff at the study site. If the follow-up letter from 
the previous site visit did not state the objectives for the next visit, then write a letter to the 
investigator. Confirm what he or she must do at the visit. 

 

8. If you have sent original CRFs to data management, then document new queries raised by 
the testing staff on a blank Testing Site Data Clarification Form. Use Template TP013, Testing 
Data Clarification Form, or similar approved format. 

 

9. Fill in the relevant Site Visit Report. Use Form TP003, Study Site Monitoring Visit Report. 
Submit it to the TTL for review according to: 

 The TMP 

 Work Instruction TP026 

 Site Visit Reports 

 Follow-up Letters. 

 

10. Follow up any pending payment or other financial issues to the Investigator / site, in 
accordance with the Testing Trial Agreement, if relevant. See Work Instruction TP009, 
Preparation of Testing Trial Agreements.  
 

Readability 
Analysis 

Passive sentences now 0% (was 40%) = Excellent. Aim for 10-20% max. 
Lower is better. 
 
Reading ease 38.4 (was 3.8) = a good improvement. 
Aim for a range of 60-70. (High is easier).* 
 
* It was difficult for me to improve these further without knowing the subject 
area, and also considering the strict testing requirements in this business 
sector. – Philip Tory. 
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Flesch Reading Ease 

One of the tests, known as the “Flesch Reading Ease” test, gives higher scores for text that is 
easier to read, and lower scores for harder-to-read passages. 

As a rule of thumb, scores of 90-100 are considered easily understandable by an average 10-year-
old. The average reader could easily understand passages with a score of 60-70, and college 
graduates with a good command of English can understand passages with results of 0-30. 

This test has become a U.S. government standard. Many government agencies require 
documents or forms to meet specific readability levels. Most states require insurance forms to 
score 40-50 on the test. The U.S. Department of Defense uses the Reading Ease test as the 
standard test of readability for its documents and forms. The test is so widely used that it is 
bundled with the popular word processing programs Corel WordPerfect and Microsoft Word. 

This Flesch Reading Ease score is a standard part of MS Word. How you run this test is covered 
in the MS Word module later on page 99. 

Flesch tested various samples and derived the following results. The target range for most 
business writing is 60-70, shown in bold: 

Sample 
Flesch Reading Ease 

(A score of 0 is very hard to read and 
a score of 100 is very easy to read.) 

Comics 92 

Consumer ads in magazines  82 

Seventeen  67 

Reader’s Digest  65 

Sports Illustrated  63 

New York Daily News  60 

Time  52 

Newsweek  50 

Wall Street Journal  43 

Harvard Business Review  43 

New York Times  39 

New York Review of Books  35 

Harvard Law Review  32 

Standard auto insurance policy  10 

USA Internal Revenue Code  -6 (!) 

Source: http://www.ravensheadservices.com/readability_checker.php 

90-100 =  Very Easy  
 80-89  =  Easy  
 70-79  =  Fairly Easy  
 60-69  =  Standard  
 50-59  =  Fairly Difficult  
 30-49  =  Difficult  
  0-29 =  Very Confusing  

The long sentence analysis of the original examples on page 54 scores less than 10! 
Many companies have this problem. 

The scores for this Training Workbook are well within target: 
Passive Sentences = 4% 
Flesch Reading Ease = 62.6 

How well does your writing score? You can run this analysis on your own documents after the 
course and see what it reveals! 
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Exercise 11 – Convert to Bullet Points and Plain English 

This exercise is about making instructions easier to follow. Here is a short instruction about 
computer system security. The original was one continuous paragraph. 

“Staff members shall not reveal personal passwords to any other person, within or outside the 
company. Staff members shall not permit any other person to access their computer account. If a 
breach of personal account security is suspected User Management and IT Support shall be 
notified immediately. In addition, staff members should avoid assigning passwords that might be 
readily discernible, such as a person’s name or birth date, or a common term (e.g., a holiday or 
name of a month). Staff members should not write down computer system passwords or record 
in other media. Failure to follow these procedures may be considered grounds for disciplinary 
action.” 

 

REWRITE THIS INSTRUCTION USING BULLET POINTS 

 Change all passive sentences to active. 

 Replace weak words (‘should’ etc); change ‘shall’ to ‘must’. (If you must, then say so). 

 Are there any difficult words that could be made easier? 

 Break it down into bullet point steps where appropriate. 

 Be direct: talk to the reader. Begin with: “As a Staff Member, you ... ” 

As a Staff Member, you 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note the difference in the way the information is given. Which of the two is quickest and easiest to 
read and understand? Do you notice anything else? 
 

(After you’ve finished – see the answer on p. 139) 
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 Your Notes:  Convert to Bullet Points and Plain English  
 
 
 
 
 
 
 

 After you finish the exercise opposite, answer these questions: 
 

1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit?  
 
 
 
 
 
 
 
 
4. Discuss your ideas with somebody else. 
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Consistency, Consistency, Consistency... 

Ambiguity and Consistency in Writing 

If you call something a “Zone Matrix Adjuster” in one part of your documentation, then always call 
it a “Zone Matrix Adjuster” throughout the documentation, not something else. If you start to call it 
a “Zone Controller”, someone will think you mean a different control and will make a mistake: you 
can guarantee it. Consistency is VITAL when there are several authors of documentation! You 
may need to agree a list of Standard Terms that you will all use. 

 

Software and Software Help Guides  

Ambiguity and Consistency in Software Documentation 

In the case of software documentation, consistency goes back to the software itself. You want the 
user to be comfortable with the product, learn it quickly, not make mistakes and not need to call 
the Help Desk. Each Support Call can cost your company £25–30. 

Unfortunately, many so-called mistakes seem to be ‘designed in’ as a feature of the application. 
As a former Software Product and QA Manager, this is one of the issues I instinctively look for. 

Consistent Product 

Shortcuts: If shortcut  means ‘Save Changes’ in five screens, then make sure you use 

shortcut  for the same function in the rest of the product, and don’t use something else. 
Be consistent. 

Buttons: If there is a “Next” button to finish a screen before you move to the next screen, then 
always call it “Next”, not a mix of “OK”, “Continue”, etc. Be consistent. 

Menus and Links: If you click a link that says ‘User Details’ but it takes you to the next screen 
with a heading ‘User Maintenance’, you now have two names for the same thing. This can be 

confusing to a new user, and could cause mistakes.  This makes it difficult to document 
properly. Be consistent. 

 Help Topic Command Path 

Show the “Command Path” at the top of each relevant Help topic, like this: 

 Menu > Tools > Options > Print tab > Update fields 

Sometimes that is all the user is looking for – “I know what I want, but where have you hidden it?!” 
– and it is very frustrating if you don’t tell them. Many a Support Call is prevented by this simple 
one-liner. 

Copy the best of Microsoft software operation 

Whether we like it or not, MS rules the roost, and most of your users will know MS software. 
Therefore, where possible, mirror the common Windows and Microsoft Office commands. It helps 
users to become familiar with your product more easily. 

Keyboard Shortcuts 

Many users use keyboard shortcuts by habit, because it is so quick to do. If something in your 
product resembles a Windows or Word function, then use the same keyboard shortcuts. For 

example, shortcut  to Open a file; shortcut  to Save details, and so on.  

Conversely, make sure a common MS shortcut doesn’t do something misleading, different or 
catastrophic if used in your product! (It happens).  (See MS Word shortcuts on page 125.) 
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Appearance and Layout 
If a document *looks good*, then people will pay attention and be more willing to read it. Why do 
newspapers and magazines pay so much attention to graphic design? Who would buy your own 
favourite magazine if there were no pictures on the cover? Black text on a white page does not sell 
magazines. First Impressions Matter! 

Cover pages in MS Word 2010 and 2007  

If you are fortunate enough to have MS Word 2010, here are some examples of standard Cover 
Page designs. (There are cover designs in other Word versions, but I do not show examples here). 
You can insert a cover page and then edit the text, change pictures and colours, etc: 
 

      

      

You can also insert these cover pages at various places throughout the document.  

Fonts and Typefaces – definitions 

“Font” means a defined Typeface + type size. “Arial” is a typeface. “Arial 10pt” is a font. 

Sans Serif fonts (like Arial, Helvetica, Univers, Verdana, Trebuchet, Tahoma) are easier to read, 

especially for on-screen use, compared with Serif fonts (such as Times New Roman). This is 
particularly true for those who do not have perfect vision, but don’t need reading glasses yet.  
Try not to sacrifice usability to style, unless your corporate style guide says you really must. 



PROFESSIONAL TECHNICAL WRITING   
 

62 Professional Technical Writing Course, to be distributed Free of Charge. Copyright © 2018 Philip Tory, Technical Author, UK 
 

Text Alignment 

Left aligned works best. Fully justified is used in paperback books where the page is narrower 
than A4. But research shows that Left aligned is easier and quicker to read; people scan it better. 
Compare these two examples: 

The configuration of the fully integrated programmable logic module enables sophisticated 
stabilisation elements of the system’s output waveform. 

 

The configuration of the fully integrated programmable logic module enables sophisticated 
stabilisation elements of the system’s output waveform. 

 
CAPITALS and Italics 

CAPITAL LETTERS  or ALL CAPS: Don’t overdo CAPITAL LETTERS for emphasis – it is more 
difficult to read, and LOOKS AS THOUGH YOU ARE SHOUTING AT ME. 
Long sentences and paragraphs in capital letters significantly reduce reading speed, and use 
25 to 35 percent more space, depending on the typeface. 
It is better to use bold for emphasis - don’t underline. 

ITALICS: In Print - do not use italics too much; a few words here and there are OK, but a block of 
italic text is more difficult to read. 
 
On Screen: avoid italics completely for normal text, as they do not reproduce well. This is because 
screen images are made up of small dots called pixels, and the slant of italic characters causes 
jagged edges to the letters. It’s harder to read. Here are enlarged examples of Arial 10pt text:  
 

 

(Enlarged screenshot example) 

 

Sub Headings: Use Sub Headings to split the text into manageable blocks. 

White Space: Don’t clutter the page up. Leave sufficient white space so that the reader does 
not feel “drowned in text”! 

Graphics: Use relevant graphics / screenshots / photographs to illustrate the subject. These are 
a great help to the readers. 

Numbered Lists: Unless you have a particular reason, try to avoid long numbered lists. 

Layout example: 

Just one block of text.     (Do you feel like reading this?) 
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Develop the structure: 

 

Add Headings and Colour 
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Add Bullet Points for Instructions 

 

Add screenshot images 

 

This is exactly the same text, but laid out in a much more attractive manner. 

 If it looks good, people will want to read it. 

 If it looks like just a block of text, the mental effort required is much greater. 
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Graphics Processing for On-Screen use 

Minimise file sizes for networks or Internet. 

If you have to deliver the documentation over a network then, these days, large images are not 
usually a problem. But if there is a slow network or broadband connections, then you need to 
optimise photographs or screen images to minimise the file size for each one. 

Photographs: use the JPG format, which 
is designed for best file size where there 
are gradual changes in shade.  

This format is not suitable for software 
screen shots where you have large areas 
of all one colour, and then closely defined 
black lines that make up text.  

JPG file sizes would be much larger, and 
the picture quality will be poorer – 
resulting in a granular appearance, 
particularly near sharp changes in colour, 
such as text. The effect is more noticeable 
in colour, and certainly on screen. 

 
Note the granular appearance in this enlargement. 

Diagrams / Screen images: use the GIF or PNG format. GIF format gives the most accurate 
colour rendition, whereas PNG can be fairly close on colour, but have a smaller file size than GIF.  

 Use your favourite graphics package (I use Paint Shop Pro) and reduce the number of 
colours in the image to 256 or lower. When reducing, select Nearest Colour, not Error Diffusion. 

File sizes for screen shots:  

The bigger the file size,  
 – the more space it takes up on your system,  
 – the slower it takes to load, 
 – the bigger (and slower) the file when you want to 
print. 

The file size of this image is: 

 GIF format = 8.8 Kb 

 PNG format = 5.5 Kb 

 JPG format = 22 Kb  

 

Inserting Images into MS Word 

There are two ways that work. Start by copying your image from somewhere, then: 

1. Either: Paste the image into place using shortcut  = Paste command. The print 
quality is good, but in Word 2007/2010 it looks blurred on screen. 

2. Alternatively: use Edit > Paste Special, in Word 2007/2010 shortcut , 
and select Picture or Bitmap. This gives the clearest image on screen, and the print 
quality is good.  
(However, if printing to PDF, the ordinary pasted image seems clearer.) 

Experiment for best practice for your PC and the images that you need to insert. 
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Annotating Images and Diagrams  

In MS Word – unstable images / annotations  

When you add image annotations in MS Word using text boxes and shapes (drawing objects) 
such as circles or arrows, these can be unstable, i.e. they can move out of place with subsequent 
editing. For example, if you add sentences above the image, the image can move down so that 
parts of the image / annotations hang down below the bottom margin. 

How to work round the instability 

I have not yet found an easy fix for this in Word, so you 
will have to experiment. Sometimes it works, sometimes 
not.  

 Insert your image; create text boxes, arrow shapes, 
etc. 

 Select all of the objects, right-click and make a 
Group. To do this in Word 2010, select the  
Home tab > Editing > Select > Select Objects:  

 

 

 Option 1: Cut the complete selected group (shortcut ) and paste it back in using 
Paste Special, as an image / bitmap. However, sometimes the text within the text boxes 
changes format.  

 Option 2: unselect the groups and take a screen shot  (Alt+PrintScreen). 
Paste it back in using Paste Special > Bitmap, then crop the image to remove the unwanted 
bits. Resize as required. 

Some users tell me they create the image / arrows / text group in PowerPoint, and then copy the 
completed image and paste it into Word as an image. It might be worth trying. 
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Guaranteed to work: use your favourite Graphics Package 

 Copy and paste your image / screen shot into your graphics package. 

 Annotate the image / screen shot / diagram with text / arrows / lines / circles, to help explain: 

 
 

Example... 

Then copy and paste the finished image back into MS Word. I have always found this to be 
completely stable and predictable in its behaviour, and you can’t “break it”.  

Which graphics package?  

Personally, I like Paint Shop Pro, and actually use an old version 7: it does all that I need. The 
newer versions are more complex and not as easy to use.  

The same goes for Photoshop: If you’re doing graphic design or processing lots of photographs 
for magazines, it’s the best. But for taking a screenshot and adding a bit of annotation, it’s over-
powered, complex and relatively expensive.  

Some people on these courses recommend GIMP, a freeware package from www.gimp.org, and 
also Paint.NET from www.getpaint.net. I’ve not tried it myself, but I have heard good reports. 

Including Flow Charts 

Be careful about using flow charts: most readers can only understand very simple flow charts.  

Complex flow charts can be a complete mystery to your readers unless they are accustomed to 
using flow charts in their everyday work.  

This is another reason to know your target reader groups. 
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Reminder: Basic Rules of Plain English 
Here are a few basic hints and tips that will make a lot of difference to the final result. 

 Plan what to write. Use a Mind Map to help you decide what the topics to write, and the 
scope of what you need to cover. (See Module 2 beginning on page 83). 

 Clarity: Be thorough, accurate, unambiguous and clear. Allow for readers whose first 
language isn’t English: there are more and more of them working in this country. 

 Actions: Use bullet points for actions. 

 Jargon: Beware of jargon and abbreviations - remember, there was a time when you 
didn’t know what they meant either! If you must use them, provide a glossary, or better 
still, define them when you first use a term in that section. 

 Familiar words: use the everyday language of the target reader. 

 KISS: Remember the K-I-S-S principle? Keep It Simple and Straightforward. More 
readers will understand you if you use simple words and simple ideas. 

 Imagine you are speaking to your reader. Write personally, in a suitable conversational 
style, and with the correct tone of voice, perhaps as if you were having a telephone 
conversation. 
Talk them through the procedure, step by step. 
Use the ‘You’ style for example: “Do this” or “do that...”; e.g. 
  – Click the button. 
  – Type your name in the field. 
  – Switch the power off before you remove the cover. 

 Weak words: Remember, ‘should’ is a weak word. If the reader ‘must’ then say so. If it is 
an option, say so, and indicate how important it may be. 
  – “You might find it helpful to...” (weak) 
  – “We recommend that...”  (medium) 
  – “We strongly recommend that...” (strong) 
  – “You must ...” (mandatory) 
Make sure you give the reader enough information to help them to make the correct 
decision. 

 Use the ACTIVE rather than PASSIVE voice where possible. For example, 
“Enter the password in the box”, rather than “The password is entered in the box”. 
“Release the spring clips and remove the battery...” not “The spring clips are released and 
the battery is removed.” 

 Keep sentences short. Aim for an average of 15-20 words, maximum 30-35 words where 
possible. 

 Use shorter words. Long words do not help easy understanding. 

 Focus.  Keep the focus on the main issues. 

 Readable:  Always check your writing. Is it user-friendly? Clear? Helpful? Polite? 

 Proof Check:  It is a good idea to ask someone else to check your writing occasionally, 
especially for important documents. Are they “technically correct”? 

 Reader Feedback:  Get feedback from the readers from time to time. If you really 
want to improve, then tell them so and ask for their help. 
– And don’t be afraid of a critic: value them. They will tell you things that your friends 
protect you from. 
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How to Write 

“I KEEP six honest serving-men,  
(They taught me all I knew); 
Their names are What and Why and When,  
And How and Where and Who.”    – Rudyard Kipling 

If someone is Lost, they need ‘Signposts in the Wilderness’ 

If someone is using a Help Manual, it is because they are unsure or don’t 
know what to do next. They may be confused and lost. They may not even 
know the questions to ask. 

When you explain something, try also to answer the questions “Why?” or 
“How?”.  This will improve the reader’s overall understanding of the subject. 

 

Ideally, give your readers enough information so they ask themselves the right questions. Then 
they can arrive at the right answers, and continue their work without asking someone else.  This is 
the objective of a good Help Guide. 

Going on a Journey... 

Imagine you get an unsigned memo addressed to you, that says: 

 
“Take the third exit at the roundabout; carry on for half a mile and take the third turning on your 
right. Go through the traffic lights, and turn off at the next roundabout. You’ll see the office about 
200 yards down there on the right. Call at reception and ask for me - I’ll be there ahead of you. 
This is important.” 
 

And that’s all it says. 

 What is missing? 

 What do you really need to know? 

 What else might you need to know?        

Write your thoughts here: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It’s the same principle when you’re writing documentation. Make sure you give the reader enough 
information so that they can follow instructions and achieve the desired result.  

Read more about Manage People’s Expectations on page 72.  
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What to Write 
In the previous sections, I covered “How to Write”. Now we look at “What to Write”. 

Where to begin 
Define the subject 

 Review your Objectives. 

 Set the boundaries. 

Scope 

 How much do you include / exclude? 

 Depends on audience & user groups. 

 Use Mind Mapping. 

Information 

 Include relevant theory – the ‘Why?’ and the ‘How’. 

 Help the user to make the right decisions. 

Researching the Subject 
What do you need to know before you begin? 

Your Competence 

Firstly, ask yourself if you are technically competent to write about this subject? Don’t be afraid to 
decline if it really is out of your sphere of knowledge. If you don’t understand the technology, how 
can you explain it to somebody else? You will only produce bad documentation and a high level of 
support calls. 

Subject Matter Experts 

Who are your Subject Matter Experts? You need quick access to those who have a thorough 
knowledge of the product or service that you are writing about. Whom might you ask? 

 Product manager? 

 The person who wrote the specification? 

 Development team? 

 Quality Control team? 

 Sales team? 

 Help Desk? 

 Trainers? 

 Installers? 

If you cannot have quick and priority access to these people, it can double the length of time that it 
takes to write the documentation. 
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Existing Documentation – is it still usable? 

Another resource is existing documentation. You might find an old version of the manual, or 
design specifications, training notes, Help Desk notes, and so on. You might be able to update 
these to the latest specification product. 

However! Check the quality of the old material. Sometimes it is quicker to rewrite the document 
from the beginning, than to try to edit something that is badly written and out-of-date. You might 
spend hours just trying to understand the differences between the old documentation and the 
latest product. 

Interviewing people 

You will be talking to the people who have the knowledge, so that you can write 
the documentation. You will take notes; but these often cannot record the whole 
conversation and catch all the details. So why not record it  in full, using a 
Digital Voice Recorder? 

I show them the device and ask, “Do you mind if my secretary takes notes? 
Then I can be sure I don’t leave out anything important from the manual.” 
Nobody has ever refused; most say it’s a good idea. 

A simple device like this one here costs about £35, and records for up to 
8 hours. You download the recording to your PC later, and then play it back to 
headphones when you type the documentation. This makes sure you have 
covered everything. There are many models on the market but, above all else, 
make sure you buy one that is easy to use. Some models are rather small and 
the control buttons are tiny.  

 

Some people like to keep information to themselves, and will tell you very little, or be unavailable 
when you need them. In this case, you may need to ask your manager to talk to their manager, 
who can in turn ask your contact to be helpful. 



PROFESSIONAL TECHNICAL WRITING   
 

72 Professional Technical Writing Course, to be distributed Free of Charge. Copyright © 2018 Philip Tory, Technical Author, UK 
 

Find out the Main User Tasks 
1. What are the main things that people DO with this product / service / procedure? 

Remember, if someone is using the documentation, they usually want to find out how to 
do something. The main approach of an instructional manual is TASK ORIENTED 
wherever possible or appropriate. What does the user need to DO? 

2. Map it out using Mind Mapping
®
 techniques. (Next course module) 

3. Arrange the topic headings into a logical sequence. 

4. Write the topics. 

IMPORTANT – Manage People’s Expectations! 
 
This is IMPORTANT! . . . Think New User.  

Imagine you’ve never seen or used this product / service / activity or technology before, but you’ve 
got to learn how to use it from a manual.  

A new user is not a 100% perfect robot, who blindly does what he/she is told, step by step. Users 
are intelligent people, like you and me. They try to follow instructions accurately, but this will 
depend on how well their upbringing, training, education and life experience prepares them for the 
next step in the process. Their minds will try to Predict or Expect what is likely to happen next – 
even if they’re wrong! They can’t help it. 

Therefore, Manage People’s Expectations. When you tell them to do something, also tell them 
what will happen when they do. Then this will confirm that they’ve “done it right” and can move on 
with confidence to the next step. 

It’s like being given Instructions for driving from your home to an address 3 miles away, when you 
don’t know the area. If it just said, turn left here; turn right at the traffic lights; take the third turning 
on the right — without giving landmarks and street names on the way, then it makes for a rather 
nervous experience.  

Instead, it needs to say something like, “Turn left at the Bell Inn pub into Station Road; at the next 
traffic lights turn right into Bridge Street – you’ll see the Morrison’s store on your left; then take the 
third turning on the right by the telephone box into Churchill Road”. This manages your 
expectations along the way. 

For example, in software, you might say,  

 Fill in the name and address boxes, and click on the drop-down selector.  

 Select the Widget type that you need, and click OK. This will take you to the Widget Settings 
screen. 

I underlined the expectation bit, which tells them what to expect when they click OK. Therefore, if 
the Widget Settings screen doesn’t appear, they’ve done something wrong and can go back and 
check.  

Remember, a computer does exactly what you tell it to do, not what you thought you’d told it to do!  
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Software documentation: write ‘Task-Oriented’ 

Don’t just describe what’s on the menu for that ‘screen’. Work out what the main tasks are that 
the User might have to perform.  

Suppose you were writing an Instruction Manual on how to drive a car . . . you want a “How To 
Drive It” manual, not a description of what’s inside the engine compartment, what’s inside a 
gearbox, how the brakes work, etc. Focus on what the User might need to Do. 

So, for software instructions, ‘talk them through’ what the various work functions or tasks they 
might need to perform.  

Imagine you have a remote computer link to the end user, so that you can see what they are doing 
on the screen. Imagine how you would speak to them on the telephone, giving them instructions 
on how to do something. Talk them through it step by step. Write down what you would say - 
possibly word for word. 
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Exercise  12 – Logical Sequence  

If switch B is on, 
   AND 
   switch C is off, 
      THEN you can continue... etc. 

Did you hear about the Bomb 
Disposal Manual that didn’t quite 
work? In chapter 3, it said: 

“Cut the red wire after you cut 
the blue wire”... 

Step by Step 

Each section needs an introduction to put the reader in context:  

 Try to order your topics in terms of workflow, or the sequence in which things happen. 

 If the reader has to do something first, then don’t wait until the end to tell them. 

 At each place where they have to make a decision about something, give them the information 
they need to make the decision. Explain the rules! 

      “IF this... AND that... then select Code 123 and press Enter” etc. 

Example: 

 
“Proceed to the third house on the right after you’ve taken the second left after the third 
traffic lights, which you come to after the first exit off the roundabout at the end of the 
bypass.” 
 

Rewrite this in the correct sequence, (and, of course, in Plain English). OK, it may seem a simple 
example, but I want you to give me a ‘polished performance’.  What is the clearest way to lay this 
out? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Remember, something may be obvious to you, but not to the reader, otherwise they would not be 
reading the Help Guide! 

(See the answer on page 139.) 



 1 – HOW TO WRITE GOOD DOCUMENTATION 

 

Professional Technical Writing Course, to be distributed Free of Charge. Copyright © 2018 Philip Tory, Technical Author, UK 75 
 

 
 Your Notes:  Logical Sequence  
 
 
 
 
 
 
 

 After you finish the exercise opposite, answer these questions: 
 
1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit?  
 
 
 
 
 
 
 
 
4. Discuss your ideas with somebody else. 
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Self-Training Pages 

The traditional way to teach new staff is for an experienced person to sit beside the new person 
and show them what to do, and how to do it. This means the ‘instructor’ cannot do their normal 
duties while coaching the newcomer – and this can be very time-consuming. 

To reduce this need, you could include a Self-Training Checklist page that can be photocopied. 
Each step refers to a particular section in the Manual or Help Guide. The new person uses the 
checklist to work through the procedures, step-by-step, and ticks off each step when completed. If 
they need help, they can ask; but if you do it right, they can often work through several sections 
without needing to interrupt the ‘instructor’. 

One customer’s Team Leader said to me, “It’s great. I give new staff one module to learn, and they 
are moving on to the next by themselves!” 

Example Training Checklist 

This example is part of training checklist from a Pharmacy Dispensing computer system. The 
descriptions on the left refer to section headings in the manual. For online Help Guides, you can 
make a clickable link that takes you direct from the item to the corresponding Help Topic. 
 

How to Dispense Medication Page no. Completed 

Dispensing to new patients    

Dispensing from patient records    

Accessing last patient    

How to add a new Doctor or Institution    

Drug quantity - various ways to set    

Drug selection with various formulae    

Warnings and Interactions – suppressing and confirming them    

Details applicable to each line    

Repeating scripts    

Altering the script using Item Edit and Abandon     

Printing blank labels    

Repeat and regular use    

Standard label on/off    

About Reports Page no. Completed 

How to produce Reports    

Patient enquiry    

Product enquiry     

Quick interaction check    

General Procedures Page no. Completed 

Data Backup    

Procedure to close down and start up    

Changing the label printer    

Pricing formulae    

Data provider – how to set up and use    
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Useful sections to include 

“How Do I?” section: 

This would show the commonest “How do I?” tasks that people do with the system / 
equipment / etc. 

“Frequently Asked Questions” section: 

This would list common Questions and Answers from the Help Desk. Ask them for a list of 
the commonest things that people telephone about. Then make sure these items are covered 
in the documentation. Or if it’s already there, why can’t the users find it? Or why can’t they 
understand it? 

Including Reference Information 

If you are writing an instructional guide, it is normally better to create a separate section for 
reference information, perhaps in an Appendix. This might include: 

 Standard forms and letters 

 Checklists 

 Report examples 

 Technical Support or Corporate Information 

 Lookup tables or reference data. 
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Model Instructions in Plain English 

FFA 90 ICE BUILD-UP BENEATH THE BOTTOM TRAY 

Symptoms: Ice forms in the bottom of the Hotpoint FFA90 Freezer compartment, below the 
bottom drawer. 

Cause: The drain hole at the back of the freezer compartment is blocked with ice and sludge. 

Tools required: 

- 7mm socket spanner 

- Phillips screwdriver 

- Clean damp cloth 

- Electric fan heater (optional, but it makes the job much quicker) 

- A length of plastic tubing approx. 3 ft (1 metre) long with 5mm bore (optional) 

- A few inches of fairly stiff but flexible, insulated wire (I used a piece of earth wire flex) 

- A torch or inspection lamp. 

Solution: Follow these instructions, which take about 20 minutes to complete. 

Preparation 

 Switch off the fridge and pull out the mains plug. 

 Remove all the freezer drawers. If there is food in them, wrap them in a duvet or something 
cosy, to reduce thawing. 

 Place a shallow tray under the front of the freezer compartment to catch dripping water. 

Thaw the Ice 

 Switch the fan heater on to low heat, and let it blow into the freezer compartment from a 
distance: NOT too close - a gentle heat is all you need. You don’t want to melt the plastic! 

 After a few minutes, use a blunt knife to prise the sheet of ice away from the bottom of the 
freezer compartment and remove it. Mop up as you go. 

Remove the inner back panel 

 Using the 7mm socket spanner, remove the 8 self-tapping, hexagonal-head screws that fix the 
back panel inside the freezer compartment. With all the screws removed, pull gently at the 
bottom of the panel and ease it out. It may stick where ice has stuck to foam rubber inside, so 
don’t pull too fast. 

 Put the panel on your draining board and allow it to thaw slowly. There will probably be ice 
embedded in the foam rubber backing. Don’t pull the ice off by hand - you might tear the foam. 

Clear the blockage 

 At the back of the freezer compartment, below the chiller tubes, there is a drain hole about 
15mm diameter, and this will probably be blocked with ice. Allow the fan heater to continue to 
thaw the ice in here, mopping up from time to time. Gently ease off any bits of ice with the 
blunt knife. As the ice thaws, the drain hole will gradually clear. 

 Insert one end of the plastic tube into the drain hole, and blow gently and steadily through the 
other. The warmth of your breath will help to thaw the ice in the drainage tube. Keep going 
until you have cleared about 5cm down. 

 Now use the piece of wire to poke gently down the hole and clear any further blockage. This 
should go down about 8-10 cm or so. Blow through the tube to clear any final blockage in the 
drainage pipe. 

Reassembly 

 Wait for the inner panel to thaw. Gently remove any remaining ice and mop it dry. Press the 
aluminium foil and foam back into place. Wipe both sides clean. 

 Inside the freezer compartment, gently mop the coolant tubing dry. Mop the circular foam seal 
around the fan, and press it back into place. 

 Replace the inner panel. DO NOT over tighten the screws, as they are self-tapping into the 
plastic walls of the freezer compartment, and you might strip the thread. 

 Replace the freezer drawers, and switch on. Everything should now be running OK.  

[Passive sentences = 2%. Readability = 79.7] 
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Report Writing  
This section is supplementary information if you write reports, and it discusses the layout or 
sections in a report. 

What are Reports for? 

Reports tell the readers about something that happened in the past, so most of the English used 
will be in the past tense. 

A report might be about: 

o analysis of oil well data 

o a medical investigation  

o radio telescope survey data  

o the cleanliness of a café 

o the servicing of an oil-processing plant  

o the implementation of a new policy 

o what happened in a motor accident 

– and so on.  

Style of Language in Reports  

Depending on the company or situation, some reports tend to be very formal. But with the move 
towards a Plain English style, these old-fashioned bureaucratic styles are changing across a wide 
range of professionals and industries.  

Use the everyday language of the target Reader Groups. You will access a wider range of 
readers, and they will read it quicker and understand it better. 

Rules for a Good Report  

1. THINK READER! The Reader is the most important person.  

2. To produce a good report takes effort. 

3. Keep the report as short as possible. Don’t waffle or pad out your sentences to make it 
“look more important”. The resulting verbiage means that the reader has to filter out the 
clutter before they can understand the main message. If you can leave out a word 
without changing the meaning, then do so. Always. 

4. Organise the report to help the READER. 

5. If you use references to other pages or other documents, check that they are correct  

6. Check your facts are correct. 

7. Check that your diagrams, tables, graphs and images are relevant, helpful, labelled or 
annotated where necessary, and in the right place for the READER. 

8. A summary tells the whole story, in miniature. 

9. Ask someone to proof check your reports for consistency and technical accuracy. (I’m 
sure they will point out any typing errors.) 

10. The appearance of the report should be as important as the contents. 

11. THINK READER! The Reader is the most important person.  
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Report Formats 

How should you format your reports? 

Many companies have defined their own format for reports, so that everybody has to write in a 
common format. Naturally, these formats vary from company to company.  

But are these templates right for the job? Many report formats were derived so long ago that 
nobody can remember who wrote them. Maybe the person who wrote them didn’t really 
understand the needs of the whole reader base. Or circumstances and working practices have 
changed, so it’s not really suitable any more.  

Beware of “We’ve always done it this way!” 

If the format does not work well for you/ some areas of your company/your customer, then ask 
around and see if you can work together on a better template.  

I cannot tell you which is the “best” format, because every situation and company has its own 
needs.  

However, here are some guidelines and ideas. If you use one of these as a “starting point”, then 
I recommend that you derive your own company standard(s). Allow for the needs of the different 
Reader Groups. And please build in some leeway, so that it is not fixed forever, but can be 
adapted if and when necessary.  

Recommendations allow for flexibility; rigid rules that are “cast in stone” can sometimes be 
counter-productive. 

Format 1: Simple Report Structure 

Here is a very basic report structure for a simple investigation: 

 Aim: What did the investigation try to establish or discover? 

 Methods: How did you carry out the investigation? What stages did you go through? 
Describe them. 

 Results: What did you discover during your investigation? 

 Conclusions: What do you conclude from your investigation? What actions do you 
recommend for the future?  

Format 2: Advanced Report Structure 

A more complex format might have the following sections: 

 Cover/Heading page: For impact, make it punchy and attractive. Create your own design, or 
use one of the MS Word templates. MS Word 10 has some nice designs. (Menu > Insert > 
Cover Page).  
I suggest you finalise the design of your cover page until you have finished the report, so that 
the appearance can reflect the overall content. 

 Table of Contents: Use MS Word fields to pick up the headings and page numbers 
automatically. (Menu > References > Table of Contents). 

 Executive Summary: This is a real ‘must’ for long reports. 

o It gives a summary of all the main elements of the report – a ‘snapshot’ view of the 
contents.  

o Emphasise your main points, and use bullet points if it seems appropriate. Cover the 
main features, results and conclusions. An executive summary could be several pages 
long. 

o Tip: Finish the report before you write this section. 
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 Introduction or Background: Use this to put the reader in context, or to “set the scene”. 

o Explain why you did the investigation; why you put the information together; why the 
report was necessary.  

o What are the objectives of the report?  

o What problems may have affected the investigation? 

 Methods: How did you carry out the investigation? What did you do? How did you collect your 
information? What was the process you used? Who was involved? What reference documents 
did you use?  

 Results: What did you discover? Tell the facts.  

o Use tables, diagrams, graphs, embedded spreadsheets, if they help the essential 
meaning. Longer or more detailed information should go in the Appendix.  

 Observations: Sometimes factual results are not enough.  

o What else influenced the investigation?  

o You can draw your own conclusions or express opinions, even if you can’t support 
your remarks with hard evidence. It might help some readers to develop their own 
thoughts further. 

 Recommendations: This is where you might recommend:  

o improvements to a design 

o changes to working practices / operating procedures / safety procedures 

o new ideas, new products and so on. 

 Conclusions: State your overall deductions from the investigation.  

o The ‘HOW’ factor. If you are recommending changes or improvements, state HOW 
these would improve things like Reliability? Safety? Productivity? Performance? 
Operation? Customer care? – and so on.  

o State your assessment of the outcomes, your evaluation of the benefits. 

o “SELL” your ideas to your readers! 

 Appendices: An appendix removes the “clutter” from the flow of the main body of the report, 
so that it reads more easily. This is where you put Reference / Supporting information. It could 
include:  

 “technical talk” for the experts who want to “dig deeper” into the investigation and 
evidence 

 lookup tables of data 

 forms and standard letters 

 spreadsheets 

 charts and tables 

 survey results, etc 

 Bibliography if you refer to other documents or reference books 

 Acknowledgements where you list the people who helped you. 

Note: Depending on your situation, choose the sections you need for your situation.  

Larger reports benefit from more sections, as it’s a convenient way of dividing them up. However, 
a short report with all ten sections might look a bit “overdone”. 
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Should you number the sections in your report? 

Opinions differ on section numbering. The “traditional” way is to number everything in sight – just 
because you can ... But is it really necessary?  

 If there is a business reason to say things like “Refer to section 2.3.17” in a certain 
report, then number the sections.  

 If you really don’t need to, then leave out numbering, and use sub-headings.  

 If necessary, restrict numbering to one or two top heading levels only.  Keep It Simple. 

Why not number everything?  

Suppose the reader has to read a lengthy report that runs to over a hundred steps. A constant 
barrage of numbers can become a distraction and an irritation that does little more than tax the 
brain. If the reader has to mentally evaluate, every time: “Is this number relevant? No” – then don’t 
number the steps. The reader’s energy is wasted processing and filtering out unnecessary 
information.  

In cases like this, you can often divide up the list into smaller sections by using subheadings. And 
give them meaningful descriptions. Each subheading then leads to maybe five or six steps before 
the next subheading, and so on. 

What about Headers and Footers in Reports? 

You can give a report style and impact if you include a relevant image in the header (or footer), 
something that relates to the report content. Or use a company logo. 

Other Report Tips 

Successful journals, magazines and newspapers pay a lot of attention to appearance and impact; 
to writing style and accuracy. You have put a lot of effort into this report, so take a little extra time 
to Make It Look Good, and give it impact. It will encourage people to want to read it. 

 Remember to do an attractive cover page; headers and footers; page numbering. 

 Use bullet points to emphasise particular points. 

 Do a thorough spelling and grammar check before you distribute your report. 

 It is difficult to be objective and thorough if you have spent several days writing something. 
If the report is important, ask a colleague to do a “technical proof check”, to make sure it 
makes technical sense, before you distribute it. And if you happen to have mis-typed 
something that the spell checker didn’t find, they will point it out to you.  
 
Some companies have proof checking in place as a standard procedure. 

 In longer reports, insert an Index-at-the-back, to help readers to find information quickly.  

Active instead of Passive Sentences in Reports 

Just as with Instructional writing, in report writing you can use active sentences instead of passive. 
This means you can use “we” to say what your team did, provided you make it clear at the 
beginning.  

“Engineers in our ABC department investigated the breakdown of the central heating system. 

First, we isolated the electrical connections... We checked the water pressure ... We tested the 
integrity of the pressure boiler... We found that...  We accept that... We recommend that...” – etc.  

Talk to the reader, and tell them what you did. 

END OF MODULE 1 
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MODULE 2 

 

 

MODULE 2 – Documentation Planning Techniques 
This module is about using MIND MAPS, which help you to plan exactly what to write, so that the 
documentation includes all relevant information and leaves out the rest.

 

Why plan my work? Why don’t I just start typing? 

Good question! 

Have you heard the saying: “Plan your work and then Work your Plan”?  This is important in 
documentation, too. You can make the task of writing so much easier if you take a few minutes to 
map out what you need to write. 

What do people find difficult when writing? 

When I conduct Technical Writing Courses, I ask delegates to complete a pre-course 
questionnaire. This gives me some idea about who the person is, what they do at work, how much 
they know already, and what they need to learn. 

In particular, I ask these questions. Here are problems that you can overcome by using correct 
planning techniques: 

What do you find most difficult in trying to write good documentation? 

 The most difficult thing for me is to figure out how to start. 

 I struggle to decide what level of technical details need to be included. 

 Planning the format of the document. 

 Trying to decide how deep you should go in a work instruction. 

 Balancing clarity and simplicity with sufficient information. 

 Planning the best way to structure the information. 

 The content! 

 Getting all of the information required by others into the document. 

 “Keeping it brief, but making sure it is comprehensive enough to be useful. 
 

What particular issues would you like me to cover in a Training Course? 

 Planning and structuring documentation projects and individual documents. 

 Getting the right Content. 

 Structure and organisation of documentation. 
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Planning what to write 

What to include? What to exclude? 
This is one of the biggest problems in writing any documentation. The bigger the manual, the 
harder it gets – it can numb the mind just trying to think about it. Some people write out a linear 
list, but this has significant limitations on the way you think. 

What is Mind Mapping? 
Mind Mapping is a sort of one-person Brainstorming tool. It is a very powerful aid for managing 
almost any kind of project. It saves a huge amount of mental energy and helps your productivity. 

Here is a definition derived from ‘Wikipedia’, the online encyclopaedia: 

“A Mind Map is a diagram used to represent words and ideas linked to and arranged radially 
around a central key word or idea. It is used to generate, visualise, structure and classify ideas, 
and as an aid in study, organization, problem solving, and decision making.” 

To put it simply, Mind Mapping is a visual “Thoughts Organiser”. It allows you to work out just how 
much to write, and it breaks the whole project down into ‘bite-sized chunks’. 

What can you use it for? 

You can use it to plan ALMOST ANYTHING! 

 Holidays 

 Writing a 140-page manual from scratch 

 Moving house 

 Restructuring your company 

 Planning an expedition to the South Pole 

 Planning your monthly reports 

 Starting a Football Club from scratch 

 Research projects 

 Weddings 

 Starting a new company. 

How do I draw a Mind Map? 

a) The main subject of attention goes at the centre, in a circle (or ellipse). 

b) Main themes radiate from the centre on branches. 

c) Each branch holds a key word as a node on that line. 

d) Expand nodes with further branches as required, until you need go no further. 
 

You will find a more detailed explanation about how to create a Mind Map on page 89. 

But first, some examples... 
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Example Mind Map 1 – Uses of Mind Maps! 
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Example Mind Map 2 – ‘Gap Gun’ User Guide 
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Example Mind Map 3 – Part of a Software Training Course 
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Example Mind Map 4: a 160-page Training Manual with full text & images 
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How does a Mind Map help with Documentation? 
Mind Maps help you to map out everything you need to write about. All relevant content has a 
place on the Mind Map, and irrelevant content is automatically omitted. Each node on the whole 
map is a sub heading for your documentation. Make Titles and Subtitles for each node into a word 
processor, and then you write text about each little bit of the subject. This is easier than being 
overwhelmed by trying to visualise the whole document in one go. 

If your brain is juggling twenty thoughts at once, you are going to drop some of them. Mind 
Mapping allows you to write them down, one at a time, in such a way that you don’t drop them, 
forget them or lose association. 

How to create a Mind Map  

1. Take a sheet of white, 
unlined paper. (Lined 
paper can restrict your 
thought flow.) 

 Use half a sheet of flip-chart paper – it gives you room to think. 

 Otherwise, use A3. (Stick two sheets of A4 together with sticky 
tape and then turn it over). A4 is limited, but OK for small maps. 

 If A3 or A4, use ‘landscape’ orientation; this gives more room for 
sentences – you can spread out more. 

2. Start in the middle 
with a brief, main Title. 

 Thoughts start in the centre of our mental world. The Mind Map 
works that way too. 

3. Put aside all pre-
conceived ideas. 

 Break free from the way you worked up until now (unless you use 
Mind Maps!) 

 Don’t draw a vertical list! 

4. Add the main themes 
around the central 
circle, like the chapter 
headings for your 
book. The order 
(sequence) doesn’t 
matter. 

 If using paper, draw a circle round each node. 

 Draw lines to connect them directly to the centre. 

 Use curved lines – they are more about flow. Straight lines can 
restrict your thinking. 

 If you like using colour then use colour. 

The main themes connect to the central image on the main 
branches, and show their relative importance. These are the core 
ideas for the rest of the Mind Map. 

5. Circles help show the 
main nodes. 

 Connect all nodes into the image, don’t leave any ‘floating’. The 
brain works by association, not by disconnected ideas.  

6. Add more main theme 
branches - think of 
other ‘Chapter 
Headings’.  

 Then your main themes will stand out clearly, and trigger your 
subsequent connecting thoughts. 

7. Start to add the next 
levels of thought.  
What themes can you 
add to each of the 
main themes? 

 First level themes stimulate associations in your mind. 

 Allow your thoughts to flow freely – attach whatever word is 
triggered next. 

 You do not have to finish one branch before moving on. You will 
probably ‘jump about’ the Mind Map as the links and associations 
occur to you. 

 The connecting lines create relationships and a structure. 

8. Add extra levels of 
data as required.  

 Keep going until you can attach no more ideas to the map. 
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Next – decide the sequence of MindMap nodes for your document 

For documentation purposes, the next step is to sort the nodes into a logical sequence for the 
document / manual / training course / report etc. These will be your documentation headings and 
sub headings. 

You can use Mind Mapping software to sort these on-screen by drag-and-drop. Otherwise, type 
the headings into your word processor as headings and sub headings, and rearrange the sort 
order in Outline View (MS Word), to arrive at the right sequence for your manual. 

There are some excellent software packages to help you create Mind Maps on your computer, 
and you can see more about these on page 91.

 

Exercise  13 – Mind Map A - select a topic 
 

Do a Mind Map for planning one of the following, something you have never done before. 

 Holiday abroad 

 House move 

 Start an Equestrian Centre 

 Banquet for 100 people 

 Start a Coffee Shop business 

 Wedding 

 Set up a Wild-Life Park tourist attraction 

 House extension 

 Sponsored Charity Event 

 Set up a Football Club with team and stadium, on a brown-field site 

 - or anything you like, but not related to work. 

Draw a detailed Mind Map for your chosen subject on a large sheet of paper, landscape format. 

 

 

Mind Map B - Plan your next documentation task 
 

 

 Map out your next major documentation project / User Manual / Software Help Guide, or 
imagine one and map that. 

 If you can’t think of one, map out a work related project: 

 An office move 

 New product / product upgrade 

 New marketing campaign 

 Reorganise your department 

Use a large sheet of paper, landscape format. 
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Mind Mapping Software 
With good Mind Mapping software, you can: 

 Export your map to a text file or Word document, so you can start work in your Word 
Processor. 

 Copy-and-Paste. 

 Export graphics, etc. 

Here are some of the software packages available, which I found by recent research on Internet 
and by practical experience. You decide which you want to use. 
 

Mindjet MindManager Pro 

 MindManager is good, easy to use and produces clear, easy to read Mind Maps. It is a 
very powerful communication tool. MindManager caters for everyone, from individuals to 
large organisations. You can even write complete documents in MindManager and 
then export the output into Word for final formatting / printing. About 1.5 million users 
worldwide. Price is around UK £295 plus VAT. 
 
See www.mindjet.com. Free 30-day trial download. 
 

ConceptDraw MINDMAP 

 See www.conceptdraw.com/en/.  Free 30-day trial download for Mac or PC users. 
 

MindGenius Business 

 See www.mindgenius.com. Free 30-day trial download for Windows. 
 

FreeMind 

 Written in Java, requires Java Runtime Environment, runs on Mac, Linux etc. Commercial 
products have more facilities, but, hey, it’s free! See 
http://freemind.sourceforge.net/wiki/index.php/Main_Page 

 
Bad News section: 

Microsoft Visio for making Mind Maps? 

 General remarks from various users in comparison tests seem to be: “Forget it!” 

 

MS Word Drawing Tools for making Mind Maps? 

 Even worse, so forget it twice!  Tedious, slow and inflexible. 
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Structuring your Document 

User Tasks 

Mind Map the User Tasks – what people actually have to do.  

Note! If your project is a software user manual, please don’t just copy the menu structure and 
design your Help Guide around that. It is rarely helpful. 

Table of Contents / List of Headings 

Derive this from the Mind Map. If you use Mind Mapping software, you can rearrange your finished 
Mind Map into a vertical column of topics by drag-and-drop. When you export to MS Word, the 
topics will then be in the same order. 

Remember to include Reference topics such as: 

 Background theory 

 Help Desk contact details 

 Tables of data. 

Start documentation in Word Processor 
 Export the MindMap into MS Word. This is the basis of your Table of Contents (ToC). 

 Go into Word, then add, delete, rearrange the ToC – get it 90% complete. 

 Set Heading Styles; make Headings and Sub-headings. 

 Start writing! Section by section. 

 

Essential Software Tools 
There are a few software packages that I consider essential for creating good Manuals and Online 
Help Guides. 

 Planning: If you write new documentation, plan it using Mind Mapping software. 

 Writing: You have to write the text, so you need a word processor such as MS Word. 

 Graphics processing: If you use images, you probably need to process them. Use Paint 
Shop Pro or similar. (MS Paint is a bit too basic to be suitable). 

 Online Help Guides: You will need a good software package such as RoboHelp, Madcap 
Flare, etc. There are several on the market. (I used RoboHelp). 

 

END OF MODULE 2 
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MODULE 3 

 
 

MODULE 3 – Working Smart in MS Word  
This covers MS Word versions 2010 and 2007 

 
Welcome to the Working Smart in MS Word module of this training course. You may have come 
across some of these points before; if you have, please forgive me for reminding you. 

It covers some of the vital aids for the Technical Author, and some useful extras that can enhance 
your work, making it better in presentation and quicker to finish. 

However, from experience, many people do not know some of the quicker ways to use Word, so 
please use this as an opportunity to learn. These will help you to improve the look of your 
documents, as well as showing you how to work quicker. 
 

If you wish MS Word still had the 2003 toolbars... 

 
 
Word 2003 was great – everything was easy to find. And then along came Word 2007 and Word 
2010, and bingo! — no toolbars, no menus — terrific… Productivity worldwide dropped by a 
reported 25% !  

If you would like to have the old toolbars back, you can buy an add-in that gives you a set of 
toolbars for the complete MS Office suite, for about £25. That could pay for itself in time 
savings in the first 2 days. 

Try it: I think there is a 15-day free trial. See www.addintools.com. Here are screenshots: 

   

Classic menus for Office 2007                                Classic menus for Office 2010 

This add-in has saved me many hours’ wasted time while I learn the new, scrambled-menus-
and-toolbars arrangement. (I wonder, how many hundred man-hours is your company losing?) 
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Essential Settings in MS Word  
Hints and Tips about getting the best out of MS Word 2010. (You’ll have to adapt from your own 
knowledge of later version menus, which have changed.) 

Formatting the Paragraph Styles 

You can customise the default settings for font (typeface and size) and colour, for the main body 
text and the heading styles that you use. Set the style once, and it applies to the whole document. 

Set the Default Font in Word:           

If many people will view your work on a computer screen, (e.g. as a PDF file, or online Help) then 
use sans serif fonts such as Arial, Calibri, Tahoma, Trebuchet and Verdana. Research shows 
that these are easier to read on the screen. 

If your work is going to be printed, then you can use a variety of serif and sans serif fonts, but 
I recommend Arial 10pt or 10.5pt. 

 To set the default font for the “normal” style, start a new paragraph and use shortcut 

  to set the ‘Normal’ style. 

 Without moving the cursor, use shortcut  to call up the Font screen: 

 
Example for default Normal style = Arial Regular 10pt... 

 Select the required Font, Font Style and Size. (You could also choose a colour and underline 
style, but I recommend that you leave the text colour as black (automatic). 

 Check your settings and then, at the bottom, click Default (Set As Default).  
You then need to confirm: 

  . Choose your option, click OK. 
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Set default Paragraph Spacing  

For the ‘Normal’ style, I recommend that you set a paragraph 
spacing of 6pt before and after each paragraph. 

 Click on a line that uses Normal style. 

 Use shortcut ,  (= format styles). The Styles 
pane opens, usually on the right of the screen. 

 Scroll up/down to find the required style ‘Normal’. 

 Hover over the selection and click on the drop-down arrow 
on the right, and then click on Modify.  

 

The Modify Style screen appears: 

 

  Only in this document: 
Select  to apply changes to this document only. 

  New documents based on this template: 
Select  to apply to all future documents based on this template.  

 Stay in this screen for the next settings... 
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Paragraph settings 

Follow the instructions on page 95, and then: 

 Format button: Now set the paragraph spacing: click on Format and select Paragraph. 
(Screen shot above). 

The Paragraph screen appears – see below. 

Alignment: set to Left aligned  

Follow the instructions above, and then: 

 Select the Indents and Spacing tab (at top left).  

 

 Alignment: My research shows that Left aligned is recommended as best for all normal text 
and headings. 
 
[Fully justified might “look nice”, with a neat right-hand edge, but research shows that it 
makes things harder to read. Two reasons are given: 

(a) The word spacing is not regular from one line to the next – some words are more widely 
spaced than others. 

(b) Sometimes, readers do not move correctly to the next line. Have you ever read the same 
line again, or skipped a line by accident? This is called a ‘tracking error’. Having a “ragged 
right margin” helps the eye to track to the next line correctly. 

See Text Alignment on page 62. 

 Indentation: Set as required – probably set both to zero, and alter later if needed. 

 Spacing Before/After: Set both to 6pt. 

 Stay in this screen for the next settings... 
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Set Line and Page Breaks 

Follow the instructions on page 95, and then: 

 Select the Line and Page Breaks tab:  

 

  Widow/Orphan control: Select this to prevent the last line of a paragraph from flowing 
over to the next page by itself. It will guarantee that at least two lines will flow over the page 
boundary. 

  Keep with next: Clear this check box for all normal paragraph text. Use it for heading 
styles. 

  Keep lines together: I recommend that you select this to prevent a whole paragraph from 
being split across a page boundary. This looks neater and improves readability. 

  Page break before: Clear this checkbox for almost all paragraph styles. Useful for 
“Heading 1” paragraph styles if you always want to start a new section on a new page, and 
start it with Heading 1. 

 To finish, click OK. 
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Set Heading Styles 1, 2 and 3 
Follow the instructions on page 97, and then: 

 Make a new line and use  to set the style to Heading 1. 

 Repeat the Format Style procedure as above on page 94, but this time select Heading 1. 
You might like to try Arial 16pt Bold and colour Dark Blue, as a suggestion. 

 Repeat for Heading 2     (e.g. Arial 14pt Regular, Dark Blue) 

           and Heading 3     (e.g. Arial 12pt Bold, Dark Blue). 

 

 Line and Page Breaks tab: For headings, it is useful to tick  Keep with Next. This makes 
sure that a heading keeps with the next sentence across a page boundary. It prevents a 
heading being left at the bottom of a page and the subsequent text separated from it on the 
next page. 

 Page break before: Tick this checkbox if, for example, you always want Heading 1 to start on 
a new page. 

 Click OK and OK again to finish, and then close the Styles and Formatting pane on the right. 

Once set, these will stay valid for the current document. 
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Spelling and Grammar Check 
The Spelling and Grammar check features are essential for the Technical Author. The Spell Check 
is obvious (but not infallible – you still need to proof read your work afterwards). The Grammar 
Check will validate your writing, and help to correct your style towards Plain English. 

Set Word to the correct Spelling Language 

When you install MS Office, the default spell-check language is English (U.S.). If you need 
UK English, make sure the default Word spelling language is changed to English (U.K.).  

Word 2007 

 Use keyboard shortcut , ; 

OR click the Office button  and then click Word Options  (at the bottom). 

 On the left, select Popular; then click Language Settings ; 
the Language Settings screen appears. 

 Primary editing language: select English (UK) and click OK: 

 

 At the next screen, confirm the changes and click OK. 
 

Word 2010 

 Select menu > File tab > Options > Language: 
 

 

 Select English (U.K.).  

 If it is not already marked as <default>, then click Set as Default, and then click OK. 
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Switch on the Grammar, Spelling and Readability Statistics  

Word 2007/2010 

 Use keyboard shortcut ,   OR 

 Word 2007: click the Office button  and then click Word Options  (at the 
bottom). 

 Word 2010: select menu > File tab > Options. 

 On the left, select Proofing: 

 

 Tick the checkboxes  as shown above. 

This switches on the Grammar checker and Readability statistics. (To read about Readability 
Analysis and Statistics, see page 102.) 
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Grammar and Style 

 Set Writing Style = Grammar & Style, and then click the Settings button. 

The Grammar Settings screen appears. 

 I recommend that you tick  the following selections (or the equivalent in other versions of 
Word): 

 
Screenshot edited to view all options together... 

 Click OK, and OK again to finish. 

While you type, Word will now check your grammar, your writing style, and your spelling. It helps 
you to learn the correct writing style, especially regarding passive sentences. 

Note: Use the prompts as a recommendation, but remember: it is not 
perfect. Use your own knowledge of good English to check the suggestions 
that Word makes. Ignore or Accept each one as required.
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Running a Spell Check 

ALWAYS spell check your work!  

 Click Review tab >  or use shortcut  to start the spelling and grammar check. 

 Make sure there is a tick in the Check Grammar  checkbox. This will then 
look for grammar mistakes and help you to correct them. 

 Note: Because English is complex, and software has its limitations, the grammar check is 
not always right. It does help you to check things you might have overlooked otherwise, 
but sometimes you know it is OK, so you click Ignore Once and continue. 

‘Technical Proof Check’ 

ALWAYS read your work, anyway. But before release, ask a colleague to do a “Technical Proof 
Check”, especially if it is important. It is hard to check your own work, and they may spot things 
you missed. 

 

Readability Analysis 
To switch on the Readability Statistics, see page 99.  

Run the Readability Analysis  

If you have made the correct settings as 
above, then when you finish the Spell and 
Grammar check, Word will show you the 
Readability Statistics for the document: 

 
 
 
 
 
 
 
 

The important part is the Readability section 

at the bottom of the screen  

 

The Flesch Reading Ease shows the readability figure for this Training Manual. The figures are in 
the middle of the target range of 60-70. 
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What if the Readability Results show as all Zeroes? 

If the Readability Statistics shows all Zeroes, this could be because there are mixed language 
sets within the document. This can happen if somebody has copied and pasted from a Word doc 
created in a foreign country. For example, a document from Germany, even if written in English, 
would have the default spell-check language set as German, and this conflicts with the Readability 
analysis.  

 To fix this, use shortcut  to select the 
whole document, then use shortcut  

,    
(this was the original Word 2003 shortcut 
derived from Tools > Languages > Language).  

 Select English (UK): 
 
 
 
 
 
 

 Click Set As Default, click OK. 
 
 

 Confirm Yes at the next screen, then click OK to 
finish. 

 

 

 Now run the F7 spelling and grammar check again, and it should now work OK. 

 

Definitions: Readability scores 

When Microsoft Word finishes checking spelling and grammar, you can set it so that it displays 
information about the Readability of the document. Each readability score bases its rating on the 
number of syllables per word, and the number of  words per sentence. 

Technical Talk: the Flesch Reading Ease formulae 

HIGHER SCORE IS EASIER TO READ 

This rates text on a 100-point scale: the higher the score, the easier it is to understand the 
document. For most standard documents, aim for a score of about 60 to 70. If your score is down 
in the 30s, then you need to have a serious look at your writing style! 

The formula for the Flesch Reading Ease Score test is: 

 

- where total words/total sentences = average sentence length (ASL) AND total syllables/total 
words = average number of syllables per word (ASW). 

As a rule of thumb, scores of 90-100 are considered easily understood by 10-11 year olds. 
13-15 year old students could easily understand passages with a score of 60-70, and passages 
with results of 0-30 will be understood by college graduates. Reader’s Digest magazine has a 
readability index of about 65, Time magazine scores about 52, and the Harvard Law Review has a 
general readability score in the low 30s.  See page 57 for more details. 

General recommendation: aim for a target Reading Ease = 60-70. 
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Reminder – Readability Rules for the Technical Writer 

If ALL your readers are graduates and have a good command of English then you can relax the 
above recommendations to some extent. However, proceed with caution! 

Remember to allow for – 

 New members of staff, or 

 those whose first language is not English. 

These readability formulae are based on average sentence length (number of words divided by 
number of sentences) and the average number of syllables per word. 

Therefore - 

 Avoid long sentences. 

 Avoid long words. 

Also, for general ease of reading large blocks of text: 

 Avoid very long paragraphs. 

This workbook scores 4% passive sentences and readability 64.8 – which is great for a training 
manual that might be used by delegates whose first language is not English. 

Please use this tool: in my experience, it is a very good indicator. 

Try it on your own work, as well as on a few documents that you find around the office – but be 
diplomatic if you tell the authors!
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Automatic Table of Contents & Index-at-the-Back  
Table of Contents (ToC) 

MS Word can create an automatic Table of Contents for you, based on the correct Heading 
Styles Heading 1, 2 and 3 that you need to use in the document. 

For a basic Table of Contents, you need to use: 

 Heading 1  – use shortcut  

 Heading 2  – use shortcut  

 Heading 3  – use shortcut  

Insert a Table of Contents (ToC) 

 Position the cursor at the point where you want to insert the Table of Contents. 

 Type the word “Contents” in normal text style to make a heading. This prevents it from 
appearing in its own Contents list. 

 Highlight the word “Contents” and use shortcut  to increase the font size to, say,  

16 or 18pt. (Use shortcut  to decrease if you make it too big.)  

Then use shortcut  to make it bold. 

 Move to the next line.  
 

Word 2007 – Insert the Table of Contents   (for Word 2010 – see next page) 

 At the top, select the References tab;  

 Click on Table of Contents  then lower down, click on Insert Table of Contents 

.  

The Table of Contents screen appears: 

 

 Tick  Show page numbers and  Right align page numbers  

 Select Tab leader ...............  and Show levels: Select the number of heading levels that you 
want to include in the ToC (normally 2 or 3), and then click OK. 
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Word 2010 –Insert the Table of Contents  

 1: At the top menu, select the References tab, then click at 2: Table of Contents . 

 

 3: Either select one of the pre-formatted Automatic Tables – OR  

4: select Insert Table of Contents and continue as on page 105 above. 

 

Update the Table of Contents (ToC) 

From time to time, update the Table of Contents manually. This will pick up new headings with 
the correct page numbers as you work.  

 Right-click once on the ToC and select Update Field > Update Entire Table > OK. 
 

Whole document: Update the ToC, Index and all links, manually 

 Use shortcut  to Select All content of the document, and then press the  key. 

 Select Update entire table  then click OK. 

 Click anywhere on the page to de-select the selection. 
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Automatic update ToC, Index and links before printing 

I strongly recommend that you set MS Word to update the Table of Contents and the Index every 
time you start a print process. 

Word 2010 

 Use shortcut ,   
OR 

 Select menu > File tab > Options.  

 

Word 2007 

 Use shortcut ,   
OR  

 Click the Office button  and then click 

Word Options  (at the 
bottom). 

 On the left, select Display. 

 At Printing Options, tick: 
 

 Update fields before printing, and 
 

 Update linked data before printing,  

 

 Then click OK. 

 
Outcome: Every time you print, first it will automatically update both the Table of Contents AND 
the Index, as well as any cross-references, bookmarks and other fields. Then it sends to the 
printer. 
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Index-at-the-Back  

THE BEST PLACE TO LOOK FOR HELP! 

A good Index of important words or phrases can help users to find information quickly, because it 
is in alphabetical order.  

This is the “Search Engine” for your manual... 

 

If someone looks only in the Table of Contents, it may not be much help, as it only shows a list of 
headings, and they’re not in alphabetical order. Headings are limited in what they can tell you. 

In MS Word, you can create an Index, based on keywords and phrases that you tag as being 
significant. Normally the Index is located at the back of a book, (but you could put it at the front if 
you wish). 
 

Create a Word Macro for tagging Index Keywords 

Microsoft has not provided an easy way to tag keywords correctly. Therefore, I have created a 
Macro (a short software programme) that allows you to use a keyboard shortcut to tag selected 
words. I have used it for more than 15 years without a problem. 

You will need to add a custom Macro to your PC first.  

This macro is on the course Resources CD, or contact me and ask for a copy by email. PT  

 

Creating the Macro, Word 2007/2010 

 Use ,  
OR  
select menu > View tab and, on the right, click on the upper part of the Macros button: 
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The Macros screen appears: 

 

 Macro name: type the name MarkTextForIndexEntry and click Create. (You can’t use 
spaces in a macro name.) 

This creates the start and end statements for the macro (Sub ... End Sub), like this: 

Sub MarkTextForIndexEntry() 

' 

' MarkTextForIndexEntry Macro 

 

' 

 

End Sub 

 Type the body text of the macro, as shown on page 110, immediately above End Sub line. 

 OR copy the macro from the course Resources CD, (or download from my web site) and then 
paste it in place of the entire macro text above. The finished version looks something like this: 

 
Example... 

 Check: It must begin with Sub and finish with End Sub. 

 Use shortcut   to save, and then shortcut   to quit. 
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MACRO: Mark Text For Index Entry  

I’m going to show you how to create this macro, and then link it to a custom keyboard shortcut 

 or   (depending on keyboard layout; see next page). 

Sub MarkTextForIndexEntry() 
' 
' MarkTextForIndexEntry Macro for MS Word 2000-2003-2007-2010 and above. 
' This macro tags highlighted text with hidden code so that it is ready for 
' inclusion in an Index (normally at the back of a document). It leaves you 
' in 'View Codes' mode so that you can see exactly the tagged text.  
' To revert to normal view, use keyboard shortcut Ctrl+Shift+* (asterisk). 
' 
' Copyright 1998-2017 Philip Tory, UK 
' Supplied free of charge, without support and without warranty of any kind. 
' We recommend that you link it to a keyboard shortcut Ctrl+Shift+\. 
' 
' To use it, just highlight the exact characters of the word or words required 
for the index, and then press 
' Ctrl+Shift+\ to tag it for inclusion in the Index. Quick-And-Easy! 
' 
' Note: When highlighting text at the end of a paragraph line, make sure you 
' *ONLY* include the exact text characters; *DO NOT* include the invisible 
' paragraph marker at the end of the line (the highlight appears to extend  
' one space beyond the last letter of the highlighted text). If you include 
' the paragraph marker, the macro does not work. 
' 
' Unlike Microsoft's manual tagging method, this removes bold or italic 
' character formatting for key words inserted in the Index, so that they  
' all have the same font in the final Index. 
' 
    Selection.Copy 
    ActiveWindow.ActivePane.View.ShowAll = True 
    ActiveDocument.Indexes.MarkEntry Range:=Selection.Range, Entry:="#", _ 
        EntryAutoText:="#", CrossReference:="", CrossReferenceAutoText:="", _ 
        BookmarkName:="", Bold:=False, Italic:=False 
    Selection.MoveRight Unit:=wdCharacter, Count:=8 
    Selection.TypeBackspace 
    Selection.Paste 
    Selection.Find.ClearFormatting 
    Selection.Find.Replacement.ClearFormatting 
    With Selection.Find 
        .Text = "XE "" " 
        .Replacement.Text = "XE """ 
        .Forward = False 
        .Wrap = wdFindAsk 
        .Format = False 
        .MatchCase = False 
        .MatchWholeWord = False 
        .MatchWildcards = False 
        .MatchSoundsLike = False 
        .MatchAllWordForms = False 
    End With 
    Selection.Find.Execute 
    With Selection 
        .Collapse Direction:=wdCollapseEnd 
    End With 
    With Selection.Find 
        .Forward = True 
    End With 
' Remove character formatting to give consistent appearance in the Index: 
Selection.MoveLeft Unit:=wdWord, Count:=4 
    Selection.MoveLeft Unit:=wdWord, Count:=3 
    Selection.MoveRight Unit:=wdCharacter, Count:=1, Extend:=wdExtend 
    Selection.Font.Reset 
    Selection.MoveLeft Unit:=wdCharacter, Count:=1 
End Sub  

Note: Macro is on Course Resources CD, or download from www.technicalwritingcourse.co.uk  
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Create a Keyboard Shortcut for the Macro 

Now create a keyboard shortcut that allows you to tag your selected words with an Index marker.  

Word 2010 

 Use shortcut ,   
OR  

 Select menu > File > Options. 
 
 

 On the left, select Customise Ribbon. 

 At the bottom, click the 
Keyboard shortcuts: Customize button: 
 

 

Word 2007 

 Use shortcut ,   
OR  

 Click the Office button  and then click 

Word Options  (at the 
bottom). 

 On the left, select Customise or 
Customise Ribbon. 

 At the bottom, click the 
Keyboard shortcuts: Customize button: 
 

 

The Customize Keyboard screen appears: 

 

 Categories: Scroll down and click on Macros. 

 Macros: (Scroll down if necessary) and click to select MarkTextForIndexEntry. 

 Press new shortcut key: Keyboards differ, so  

choose 3 keys at the bottom left-hand corner of the 

keyboard. Click in the box and press the shortcut,  

e.g.   or    ...   or  

 Click Assign and then  

 click Close. 

You are now ready to tag your selected text for use in the Index. 
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How to Tag Keywords for the Index 

NOTE CAREFULLY: 

 Make sure you only highlight the required words, and NOT the space at the end. 
Especially if your tag includes a word at the end of a heading or sentence.  
  
1: It helps if you first insert a space at the end of the heading,  
2: then select the exact words excluding the space. (If you accidentally capture the hidden 

paragraph marker ¶, the macro fails: use  a few times to undo). 

 Tag the words using a keyboard shortcut to run the macro. 

When finished, this leaves you in the “Reveal Codes“ mode, showing you the words that it has 
tagged for the Index, like this example: 

 

You can switch the Reveal Codes mode ON and OFF using the toolbar >  button, or quicker 

still, use the keyboard shortcut .  (Remember this one – it’s useful!) 

How to Insert a Keyword Index-at-the-back 

To insert an Index of keywords at the back of your document: 

 Use shortcut  to go to the very end of the document and start the Index on a new 

page. Use the shortcut  for a hard page break. 

 Type the word Index & apply a heading style, say, Heading 1 (shortcut ). 

 Go to a new line. 

Word 2007/2010 

 Select the References tab > Index section > click Insert Index. 

 
The Index and Tables screen appears. Select the Index tab: 

 

 Make settings as required. I recommend you use those shown above. Then click OK. 

This inserts an automatic Index based on the tagged keywords that you have used in the 

document. You may need to put a manual page break  before the word “Index”. 
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Identifying Keywords 
How do you know which words to tag as keywords for the Index? 

 IDENTIFY. Think how someone uses an Internet search engine. 

 What thoughts are in the user’s mind if they want to find something on the page you’re 
tagging? 

 Include verbs / actions, such as: 
– ‘Add user’ 
– ‘Change password’ 
– ‘system backup’ 
– ‘Printing reports’. 

 Reference words / phrases: 
– ‘Help desk’ 
– ‘Modem settings’ 
– ‘Disclaimer’. 

 Include alternatives: ‘amend address’, ‘change address’, ‘update address’; 
– OR stick to one only throughout the documentation 

 Tag: 
– significant screen text 
– labels on equipment 
– names of other reference documents. 

Update the Index 

 To update the Index so that it picks up new index keywords and the correct page numbers, 
right-click on the table and select Update Field. 

 

See Automatic update ToC, Index and Links before printing on page 107. 
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Exercises on Identifying Keywords for the Index 
Which words would you tag for the Index-at-the-back? 

 

On the following pages are two keyword exercises, each spanning TWO pages  
 

 Use a highlight pen to mark the words or phrases you would tag for the Index.  

 

 Your Notes on  Exercises 14 and 15 Highlight Keywords & Phrases    
 
 
 
 
 
 

After you finish the exercises on the following pages 116 and 118, answer these 
questions: 
 
1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit? 
 
 
 
 
 
 
4. Discuss your ideas with somebody else. 
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Exercise 14 – Highlight Keywords & Phrases 

The following extract comes from a Software User Manual. Use a highlight pen to mark 
all the words or phrases that you would tag for the Index.  

Adding QSoft Users 
menu > Utilities > User Maintenance 

This Help topic tells you how to add new Users onto QSoft, set their system role,  
and set a new password. 

There are three categories of QSoft user. 

o Administrators, who can access all facilities in QSoft. 

o Users, who can access most facilities, but cannot access system setup features. 

o No Role, not defined yet – still in development. Do not use this for the time being. 

To change somebody’s role, please see below. 

 Note: You must be a QSoft Administrator to access this facility. 

View list of Users 

 Go to menu > Utilities > User Maintenance. 

The User Details screen appears. 

 
Example User Details window... 

Here you can see the current users on the system. 

 

Add New User 

 Use Ctrl+N to add a New User. 

 Enter their full name. 

 Then enter their login User Name. For example, for John Williamson you might use the 
abbreviation “JohnW”. 

 Enter the person’s new password. Type it carefully - there is no double-check for typing 
errors here. Make a note of what it is and hand it to the new user. Remember to keep it 
secret. 
At the Role drop-down, select their Role as a QSoft User: will they be an Administrator, 
or an ordinary User? 

(  The ‘No Role’ function is not available yet; subject to further development). 

 Optionally, you can enter remarks about this person; it could be anything. You might 
want to keep their home telephone number here, for example. 

 Finally, use Ctrl+S to save changes and close. 
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Issue New Password 
You have to be a QSoft Administrator to issue new passwords. 

If a member of your staff has forgotten their password, you can come into this screen and issue 
them with a new one. 

 View the list of users. 

 Click to select the relevant person in the list. 

 Click in the Password field on the screen where you can enter information, or where 
information is displayed. Delete the asterisks and enter a new password. 
(  See Choosing a Password on page 37.) 

 For security reasons, QSoft does not show you the characters as you type. (It does not 
double-check at this point for typing errors, so type carefully!) 

 Tell the new user, in private, what their new password is. This will be valid next time 
they log in. 

 It is good password security practice if the user changes their password next time they 
log in. 

 Finally, use Ctrl+S to save changes and close. 

 

Change Role 

QSoft users have three categories - Administrator - User - No Role. 

 View the list of users. 

 Click to select the relevant person in the list. 

 At the Role drop-down, select a new role level. 

 Finally, use Ctrl+S to save changes and close. 

 
 See related topics:  Choosing a Password on page 37 and 

Changing your Password on page 48. 
 

(Passives = 2%, Reading ease=70.4) 

 
1. When you have finished, swap your work with somebody else. 

2. Check their key phrase selections. 
    – Do you agree? 
    – Did they miss any? 
    – Did they mark any that would not be valid? 
    – Why are they not valid? Discuss. 
 
 
 

 DO NOT TURN TO THE NEXT EXERCISE YET!  
 
 

After you’ve finished – see the answer on p. 140 
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Exercise 15 – Highlight Keywords & Phrases 

The following extract comes from documentation for a Ship Tracking System. 

Use a highlight pen to mark the words all the words or phrases that you would tag for the Index. 
 
  
 
 

Find Ship Details 

Oilspace > Ship Directory screen 

 
This topic tells you how to find a Ship and look up its details. For information purposes only. 
 

You can look up the details of any ship listed in the World Shipping Directory Fairplay database. 

It shows you information such as Speed and Consumption, Technical Information, Commercial 
Information, Name History, tonnage, deadweight and so on. 

 In the Ship Directory pane, click in the Name field and delete any name that is already 
there. 

 Start to type the new name. You can type the first few letters, or the whole name if you 
wish. (1) 

 Press Enter, OR click on Search. (2) The search will find any name that matches the 
letters you type in, wherever they appear in the ship’s name. For example, if you type 
“tain”, it will find names that include “Captain”. 

 
Example search for ship “Baltic Captain I”... 

The system searches and displays a list of matching names. (3) 

 To view the details of this Ship, click on the required Name in the list. (3) 

 If the name does not appear in this view, click on Next at the bottom of the Ship 
Directory screen. Wait for the screen to refresh and show you the next set of 
matching ship names. (To return, click Prev to see the previous set.) 
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The Ship Information screen appears: 

 

Note: The blue Commercial Information links are not active in this version. 

 When you have finished, click OK to return. 

Change number of rows to view  

The Ship Directory screen shows you a preset number of rows of search data. 

 

 To change the number of rows to view, click in the Return   rows field, change 
the number and press Enter. 

 

 
(Passives = 0%, Reading ease=78.3) 

 

1. When you have finished, swap your work with somebody else. 

2. Check their key phrase selections. 
    – Do you agree? 
    – Did they miss any? 
    – Did they mark any that would not be valid? 
    – Why are they not valid? Discuss. 

 

After you’ve finished – see the answer on p. 142 
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Navigation: Inserting Cross References / “See also” 
hyperlinks 
It is useful to provide cross-reference links to other sections in a Manual; for example: 
“See also ‘Jargon and Acronyms’ on page 31.” But how do you insert a page number that will 
update automatically as you add new content to the manual? 

 First, decide where you want to place the cross reference, and type the necessary text; for 
example, “ See also ‘Jargon and Acronyms’ on page “. Now, instead of typing the page 
number manually, position the cursor where you want to insert the page number reference. 
Then – 

 At the top menu, select the References tab. 

 Then click on Cross-reference: 

 

The Cross-reference screen appears: 
 

Reference Type: Select your chosen target 
type, normally Heading, or select what you need to 
hyperlink to. 

Insert reference to: You might select Page 
number, or perhaps Heading number. 

Insert as hyperlink: Tick this check box. 

For which Heading: Scroll down and select the 
item that you want to refer to. 

 

 Click Insert and then click Close. 

This inserts the “hyperlink” that displays the page number.  

Remember to set the links to update automatically before printing – see Automatic update before 
printing on page 107. 

Note: While you are working in Word, you can use Ctrl+Click on the hyperlink, and you will jump 
to that page number.
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Tips for Layout 

 Some reminders, in case you have forgotten...  

Tips for setting Tabs 
Sometimes you want to put a short heading on the left and then, say, a date on the right. 

Word 2007/2010 

 Make sure View tab > Show > Ruler is selected (click 
to tick): 

  

 Type your text. 

 *Click on the small Tab control button at the top left of the page 

area. Click again until it changes to ‘Right Tab’ like this : 

 

 

 Point the mouse to somewhere to the right-hand end of the ruler, and click. This inserts the tab 
marker. Drag it to the right-hand edge: 

 

 Now return to the page text area. Click at the end of the line of text and press the  key. 
This now inserts a right-aligned tab. 

 Now type your text, e.g. the Date (or whatever you want to appear on the right). Job done! 
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Tips for working with Tables 
Many of you will have used Tables to lay out information in rows and columns. Here are some 
useful tips. 

Use tables to keep images beside text 

Unstable floating images: You may have noticed that trying to float images beside text is 
unstable. The picture never seems to stay in place, and the text flow around it is unpredictable – it 
can jump out of position by the smallest editing of nearby text. 

To overcome this problem, use a 2x1 table with invisible borders. Put the image on one side and 
the text the other side: 

 Select top menu > Insert > Table. A drop-down menu appears. 

 Hover over the second cell in the top row, and the screen shows “2x1 Table”, then click to 
select: 

 

This creates a simple table like this: 

  

 Click in the left-hand cell. 

 Hold the  key down and then click in the right-hand cell. This selects both cells of 
the table. 
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Word 2007 / 2010 

 First, click in the table. Then the Design tab appears at the top toolbar. 

 

 Click the Design tab at the top ............................  — 
 

 Click on Borders, and a drop-down menu appears  
 
 
 
 
 

 Select No Border:   .............................................  — 

 

You should now see the table outlined in faint grey lines, like this:  
 

  

If you cannot see the table lines at all, you need to switch on an option to Show text boundaries, 
like this: 

Word 2010 

 Use shortcut ,   
OR  

 Click menu > File > Options. 

 On the left, select Advanced. 

 On the right, scroll down nearly halfway to 
the Show document content section, then 
tick the checkbox beside Show text 
boundaries, and then click OK. 

Word 2007 

 Use shortcut ,   
OR  

 Click the Office button , then click 

Word Options  (at bottom). 

 On the left, select Advanced. 

 On the right, scroll down nearly halfway to 
the Show document content section, then 
tick the checkbox beside Show text 
boundaries, and then click OK. 

The lines that you can see on screen will not actually appear in print – they are just there to show 
you the cell boundaries. If you want to check, use menu > File > Print Preview.  

[I added grey lines into the example above so that you can see what I mean.] 
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How to Locate an Image beside Text 

 Create a table of one row and two columns. 

 Paste the image into one cell, and type your accompanying text into the other, like this 
example: 

 

 To close your application, click on the red Close icon at the top 
right-hand corner of the screen. 

 Now make the borders invisible. Select the whole table and then click the “No Border” icon. 
(This screenshot is from Word 2010): 

 

This is the result: 

 

 To close your application, click on the red Close icon at the top 
right-hand corner of the screen. 

 

The image and the text will now sit beside each other in a well-behaved and predictable manner.  

If you move the table down to another page by inserting text above it, the complete table will jump 
to the next page, with the image in perfect alignment.  

The same technique is used in web page design. 
 

Annotating Images 

 See Annotating Images and Diagrams on 
page 66. 
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Learn your Keyboard Shortcuts! 

 Learn your keyboard shortcuts!  
It’s much quicker than using a mouse. 

 Research shows that most tasks in Microsoft 
Word are performed three times faster with the 
keyboard instead of the mouse.  

 

I have highlighted those that I find particularly useful, like this:  

Quick Commands that move the Cursor 

Move cursor to a character, word, paragraph, column, or object 

MOVE ACTION KEYS  

One character to the left Left Arrow  

One character to the right Right Arrow  

One word to the left Ctrl+Left Arrow 
 

One word to the right Ctrl+Right Arrow 
 

One paragraph up Ctrl+Up Arrow 
 

One paragraph down Ctrl+Down Arrow 
 

One column to the left (in a table) Ctrl+Up Arrow  

One column to the right (in a table) Ctrl+Down Arrow  

 
Move cursor to a line, to a page, to a screen, to the beginning or end of a 
document, or to the previous revision 

MOVE ACTION KEYS  

Go up one line Up Arrow  

Go down one line Down Arrow  

Go to the end of a line End 
 

Go to the beginning of a line Home 
 

Go up one screen Page Up  

Go down one screen Page Down  

Go to page number ... Ctrl+G 
 

Go to the very end of a document Ctrl+End 
 

Go to the very beginning of a document Ctrl+Home 
 

Go back to last edit position (stores 3 places). 

This is very useful if you want to return to the place you 
were last working when you closed the document. 

Just open it again and use Shift+F5. 

Shift+F5 
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Edit commands 

EDITING KEYS  

Undo Ctrl+Z  

Repeat  Ctrl+Y  

Clear Delete  

Cut text or graphics (this removes the original from its 
current position so that you can paste it somewhere else). 

Ctrl+X  

Copy selected text or graphics. Ctrl+C  

Paste text or graphics. 
Paste Special 

Ctrl+V 
Ctrl+Alt+V 

 

Select All (whole document) Ctrl+A  

Find Ctrl+F  

Replace Ctrl+H  

Go To (e.g. page number) Ctrl+G  

Reveal codes   ( toggle action) Ctrl+Shift+8  

Deleting text and graphics 

DELETING KEYS  

Delete one character to the left of the insertion point Backspace  

Delete one word to the left of the insertion point  Ctrl+Backspace  

Delete one character to the right of the insertion point Delete  

Delete one word to the right of the insertion point Ctrl+Del  

Cut (delete) selected text Ctrl+X  

Undo the last action Ctrl+Z  

Inserting special codes 

INSERT CODES KEYS  

Manual line break - moves you to the next line within the 
same paragraph. 

Shift+Enter  

Manual page break – forces a ‘start new page’.  Ctrl+Enter  

Non-breaking hyphen (stops a word splitting across a line 
break) 

Ctrl+Shift+Hyphen  

Non-breaking space (stops two words splitting across a line 
break). For example, if you want “9 mm” to stay together at 
a line break.  

Ctrl+Shift+Spacebar  

Copyright symbol © Ctrl+Alt+C  
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Changing Font Size and change Word Case 

FONT SIZE / CASE ACTION KEYS  

Increase font size of selected characters by 1 point.  Ctrl+]  

Decrease font size of selected characters by 1 point. Ctrl+[ 
 

Change the case of a word  Word  WORD. Highlight the 

word(s) you want to change, and then use — 

Shift+F3 
 

Using shortcut keys to format paragraphs 

Setting paragraph alignments and indents 

POSITIONING ACTION KEYS  

Centre a paragraph Ctrl+E  

Justify a paragraph Ctrl+J  

Left align a paragraph Ctrl+L  

Right align a paragraph Ctrl+R  

Indent a paragraph from the left Ctrl+M 
 

Remove an indent from the left Ctrl+Shift+M 
 

Create a hanging indent Ctrl+T 
 

Reduce a hanging indent Ctrl+Shift+T 
 

 

Applying Styles 

STYLE ACTION KEYS  

Apply the Normal style Ctrl+Shift+N 
 

Apply the Heading 1 style Ctrl+Alt+1 
 

Apply the Heading 2 style Ctrl+Alt+2 
 

Apply the Heading 3 style Ctrl+Alt+3 
 

Apply the List Bullet style Ctrl+Shift+L 
 

Remove character styles from selected text Ctrl+Space  
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Final Exercise – Start your own Documentation 
Start your own Technical Writing projects: 

 Define the reader group(s) 

 Do a Mind Map 

 Forget how you’ve done it before: take a fresh look! 

 Make it TASK-based where possible - what do people need to DO? 

 Create the Table of Contents 

 Add the Introduction, Help Desk details, Reference topics etc. 

 Remember to Manage the user’s Expectations. 

Summary 
We have covered: 

 How to write Good Documentation 

 How to use Plain English 

 How to plan your work using Mind Maps * 

 How to use MS Word to analyse our work. 

 MS Word Hints and Tips. 

 

 

 

 

END OF MODULE 3 
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APPENDIX 

 
 
 
 
 

Answers to Exercises 
 

and 
 

Further Reading 

 
 
 
 
 
 
 

No cheating! 
 

Please do the exercises 
BEFORE you look at 

the answers! 
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Answers 2 – Convert Long Sentences to Short  

 
See the exercise on page 16. 

 

REWRITE THESE LONG SENTENCES INTO SHORT AND MEDIUM SENTENCES.  

“The Document Administrator shall check that procedures have been formatted correctly, 
including the Footer or for Mechanical Integrity documents, the Header, (Issue No. and Date, 
Revision No and date, Document Number and Title, Page Numbering and review period interval 
etc); whether any hard copies are required and if so the distribution and copy numbers, or 
alternatively for electronic only masters, that no hard copies are required, but showing who 
needs to be communicated with if the document should change (by job title); the format should 
comply with the document control template.”  (91 words, Reading Ease 24.5) 

 

The Document Administrator must check that procedures are formatted correctly.  

 Footers (or for Mechanical Integrity documents, the Headers) must include: 
  – Issue No. and Date 
  – Revision No. and date 
  – Document No. and Title 
  – Page Numbering  
  – Review period interval, etc. 

 Are any hard copies required? If so, check the distribution and copy numbers. Alternatively, 
for electronic-only masters, check that no hard copies are required. 

 If the document changes, do the procedures show who to inform (by job title)? 

 Does the format comply with the document control template?  (Reading Ease 47.3) 

 

REWRITE USING SHORT AND MEDIUM SENTENCES. 

“The Clinical Team Leader or designate (CTL): Develops the Clinical Management Plan (CMP) 
(Operating Procedure CS.OP.CM010, Clinical Management Plan), defines the Data Query 
process, co-ordinates the monitoring activities of the Monitor, including development and 
distribution of monitoring guidelines, and review of the associated site visit report.” 
 (Reading Ease 0) 

 

SHORT SENTENCES: 
 
The Clinical Team Leader or designate (CTL): 

 Develops the Clinical Management Plan (CMP). Refer to Operating Procedure CS.OP.CM010, 
Clinical Management Plan. 

 Defines the Data Query process. 

 Co-ordinates the monitoring activities of the Monitor. This includes developing and distributing 
the Monitoring Guidelines, and reviewing the associated Site Visit Report. 

(Reading Ease 11) 
 

 

QUESTION 

 How do these this compare with the original? 

 Which is easier to understand? 
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 Your Notes:  Answers 2: Convert Long Sentences to Short  
 
 
 
 
 
 
 

 What have you learned from the answer opposite? Write yourself a reminder 
below: 
 
 
 
 
 
 
1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit?  
 
 
 
 
 
 
 
 
4. Discuss your ideas with somebody else. 
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Answers 4 – Convert PASSIVE Sentences to ACTIVE  

 
See the exercise on page 24. 

 

Before:  

The following activities will be conducted in accordance with the Research Management 
Plan (RMP). Data Collection Files (DCFs) may be generated by Data Management (DM) 
or Research staff during the data query process.  DCFs may be provided to the 
Supervisor for resolution at the testing site as specified in the Scope of Work and the 
RMP. If DCFs are provided directly to the site by someone other than the Supervisor, the 
CTL will request that copies of the DCFs be provided to the Supervisor. 

The visit timing is to be confirmed with the relevant study site staff, and a confirmation 
letter is to be provided detailing to the investigator what is to be accomplished at the 
visit, if these details were not included in the previous site visit follow-up letter. 

(Passive 100%, Reading ease 37.2) 

 
REWRITE THE PROCEDURE USING ACTIVE SENTENCES = Subject > Verb > Object 

After: Here is a suggested solution – you might have a version that is similar to this: 

 
Conduct the following activities according to the Research Management Plan (RMP). 

Data Management (DM) or Research staff may generate DCFs during the data query 
process. You may provide DCFs to the Supervisor for resolution at the testing site as 
specified in the Scope of Work and the RMP. If someone other than the Supervisor 
provides DCFs directly to the site, the CTL will ask you to provide copies to the 
Supervisor. 

Confirm the visit timing with the relevant study site staff. If the previous site visit follow-
up letter did not include details of what to accomplish at the visit, write a letter to tell the 
investigator. 

 (Passive 0%, Reading Ease 46.8) 

 

QUESTIONS 

 How does this compare with the original? 

 Which would be easier to understand? 
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 Your Notes:  Answers 4 – Convert PASSIVE Sentences to ACTIVE  
 
 
 
 
 
 
 

 What have you learned from the answer opposite? Write yourself a reminder 
below: 
 
1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit?  
 
 

 
 
 
 
 
 
Discuss your ideas with somebody else. 
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Answers 5 –Find the Passive Phrases  

 
See the exercise on page 26. 

 

Here, the passive sentences have been highlighted. There is also a cross X in the right-hand 
margin beside any sentence that does not define clearly who has to do the (passive) action. 

 

Conducting a Supervisory Visit 

A Supervisor must address all activities described below over the course of Supervisory the study 
in accordance with the RMP (Research Management Plan) or equivalent documentation and 
instructions.  However, not all of the activities described in this section may necessarily 
be performed at each interim Supervisory visit.  

- Meet with study site staff and/or Investigator to obtain an overview of study progress and any 
issues since the previous contact, and to identify any issues that require additional site 
training. 

- Ensure that all new and on-going Immediately Reportable Adverse Events (IRAEs) and 
Unanticipated Adverse Device Effects (UADEs) have been documented, reported and 
followed up appropriately.  

- Verify continued acceptability of study site staff and facilities and discuss any planned 
changes.  If changes occur, check whether the appropriate RDs are updated.  

- Determine the status and review the time line for completing pending and outstanding issues 
from previous contact(s). 

- Verify compliance with the informed consent procedures and conformance with the required 
subject visit schedule, and confirm whether all study-specific procedures were performed 
after written consent was obtained.  

- Review the accuracy, completeness, and legibility of the CRF entries, DCFs, source 
documents, and other trial-related records against each other, and ensure that any known 
deviations from the protocol are documented.  

- Review the Investigator Site File or equivalent and determine whether the investigator or 
designate is maintaining the RDs, Research Study Documents (RSDs), forms, logs and other 
study documents appropriately. 

- Check whether any changes to data on CRFs were made by authorised study site staff and 
were initialled and dated. 

- Check that the Investigator has verified the accuracy of all DCFs, if applicable. 

- Check that resolved DCFs are filed at the study site.  

- Check whether the Investigator or authorised designate has reviewed all research results, 
including abnormal laboratory results. 

- Inspect the storage conditions of laboratory kits, expiration date and adequacy of supplies. 

- Document and discuss with the Investigator and/or designated staff any issues relating to the 
handling and documentation of IP, including storage conditions, IP records, reconciliation, 
expiration date and adequacy of supplies. 

 
 (Passives 41%. Reading Ease 17) 

 

 

X 

X 

X 

X 

X 

X 
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 Your Notes:  Answers 5 – Find the Passive Phrases  
 
 
 
 
 
 
 

 What have you learned from the answer opposite? Write yourself a reminder 
below: 
 
1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit?  
 
 

 
 
 
 
 
 
Discuss your ideas with somebody else. 
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Answers 9 – Simplify and translate into Plain English (1) 

 
See the exercise on page 52. 

 

 
‘Certain of the components comprising our electrical appliances have inherent 
characteristics the effect of which, whether before or after such components have been 
introduced into appliances or during such introduction, make it desirable, in the interests 
of safety, for the introduction of spare components into, and/or the repair of, our 
appliances to be carried out by a competent person. The parts now supplied are done so 
on the clear understanding that such introduction and/or repair will not be otherwise 
interfered with beyond the extent of normal cleaning as recommended in the operating 
instructions, and that no liability attaches to ABC Electrical Appliances Limited for any 
damage or personal injury from such introduction and/or repair.’  
 
 (117 words, Passive sentences 100%, Reading Ease = 0) 
 

(From a Safety Leaflet. Company name changed to protect the guilty!) 

 

Write a new Safety Leaflet in Plain English. 

 
After: Here is a suggested solution: 
 

 

 In the interests of safety, only a competent person should do repairs. 

 Once fitted, do not interfere with these parts, apart from normal cleaning as described in the 
manual. 

 ABC Electrical Appliances accepts no liability for damage or personal injury that occurs 
because of any repair. 

(46 words, Reading ease=43) 
 

 

QUESTIONS 

 How does this compare with the original? 

 Which is easier to understand? 
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 Your Notes:  Answers 9 – Simplify and translate into Plain English  
 
 
 
 
 
 
 

 What have you learned from the answer opposite? Write yourself a reminder 
below: 
 
1. How could you apply this in your writing at work? How might you use this in future? 
 
 
 
 
 
 
 
 
2. What difficulties would this overcome? 
 
 
 
 
 
 
 
 
3. What kinds of existing documentation would benefit?  
 
 

 
 
 
 
 
 
Discuss your ideas with somebody else. 
 
 
 
 



PROFESSIONAL TECHNICAL WRITING   
 

138 Professional Technical Writing Course, to be distributed Free of Charge. Copyright © 2018 Philip Tory, Technical Author, UK 
 

 
 

(This page is intentionally blank.) 



 APPENDIX – ANSWERS TO EXERCISES 

 

Professional Technical Writing Course, to be distributed Free of Charge. Copyright © 2018 Philip Tory, Technical Author, UK 139 
 

Answers 11 – Convert to Bullet Points and Plain English  

See the exercise on page 58. 
Before: 

“Staff members shall not reveal personal passwords to any other person, within or outside the 
company. Staff members shall not permit any other person to access their computer account. If a 
breach of personal account security is suspected User Management and IT Support shall be 
notified immediately. In addition, staff members should avoid assigning passwords that might be 
readily discernible, such as a person’s name or birth date, or a common term (e.g., a holiday or 
name of a month). Staff members should not write down computer system passwords or record in 
other media. Failure to follow these procedures may be considered grounds for disciplinary 
action.” 

                     (BEFORE) 

After:  Suggested solution 

As a Member of Staff: 

 You must not reveal passwords to anybody else, within or outside the company. 

 Do not let anyone else access your computer account. 

 If you suspect a breach of personal account security, you must tell User 
Management and IT Support at once. 

 Do not use easily guessable passwords, such as a name, a date of birth, a 
holiday, or the name of a month. 

 Do not write down passwords or store them in any other media. 

If you do not follow these rules, we may take disciplinary action. 

                     (AFTER) 

QUESTIONS 

 How does this compare with the original? 

 Which is easier to understand? 

Note how the Reading Ease has improved. 

 

Answers 12 – Logical Sequence   

See the exercise on page 74. 

“Proceed to the third house on the right after you've taken the second left after the third traffic 
lights, which you come to after the first exit off the roundabout at the end of the bypass.” 

 

At the end of the bypass, there is a roundabout. 

 Take the first exit. 

 Continue until you come to the third traffic lights. 

 Go through the traffic lights and take the second turning left. 

 Go to the third house on the right. 
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Answers 14 – Keywords  – Highlight Keywords... 

These are suggested answers for the Keywords Exercise on page 116. 

Adding QSoft Users 
menu > Utilities > User Maintenance 

 
This Help topic tells you how to add new Users onto QSoft, set their system role, and set a new 

password. 

 

There are three categories of QSoft user. 

o Administrators, who can access all facilities in QSoft. 

o Users, who can access most facilities, but cannot access system setup features. 

o No Role, not defined yet – still in development. Do not use this for the time being. 

To change somebody’s role, please see below. 

Note: You must be a QSoft Administrator to access this facility. 

View list of Users List of Users 

 Go to menu > Utilities > User Maintenance. 

The User Details screen appears. 

 
Example User Details window... 

Here you can see the current users on the system. 

 

Add New User 

 Use Ctrl+N to add a New User. 

 Enter their full name. 

 Then enter their login User Name. For example, for John Williamson you might use the 
abbreviation “JohnW”. 

 Enter the person’s new password. Type it carefully - there is no double-check for 
typing errors here. Make a note of what it is and hand it to the new user.  Remember to 
keep it secret. 

 At the Role drop-down, select their Role as a QSoft User: will they be an Administrator, 

or an ordinary User? (  ‘No Role’ is not available yet; subject to further development). 

 Optionally, you can enter remarks about this person; it could be anything. You might 

want to keep their home telephone number here, for example. 

 Finally, use Ctrl+S to save changes and close. 
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Issue New Password 

You have to be a QSoft Administrator to issue new passwords. 

If a member of your staff has forgotten their password, you can come into this screen and 
issue them with a new one. 

 View the list of users. 

 Click to select the relevant person in the list. 

 Click in the Password field on the screen where you can enter information, or where 
information is displayed.  Delete the asterisks and enter a new password. 
(  See Choosing a Password.) 

 For security reasons, QSoft does not show you the characters as you type. (It does not 
double-check at this point for typing errors, so type carefully!) 

 Tell the new user, in private, what their new password is. This will be valid next time 
they log in. 

 It is good password security practice if the user changes their password next time 
they log in. 

 Finally, use Ctrl+S to save changes and close. 

 

Change Role 

QSoft users have three categories - Administrator - User - No Role. 

 View the list of users. 

 Click to select the relevant person in the list. 

 At the Role drop-down, select a new role level. 

 Finally, use Ctrl+S to save changes and close. 

 

 See related topics: Choosing a Password Changing your Password Don’t highlight these! 

 
Note – don’t tag the “See related topics” links, because the actual content is somewhere else! 

 

Check your key phrase selections. 

    – Do you agree? 

    – Did you miss any? 

    – Did you mark any that would not be valid? Why are they not valid? 
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Answers 15 – Keywords Exercise  – Highlight Keywords 

These are suggested answers for the Keywords Exercise on page 118.  

Find Ship Details Ship details 

Oilspace > Ship Directory screen 

 
This topic tells you how to find a Ship and look up its details; for information purposes only. 
 

You can look up the details of any ship listed in the World Shipping Directory Fairplay database. 

It shows you information such as Speed and Consumption, Technical Information, Commercial 

Information, Name History, tonnage, deadweight and so on. 

 In the Ship Directory pane, click in the Name field and delete any name that is already 
there. 

 Start to type the new name. You can type the first few letters, or the whole name if you 
wish. (1) 

 Press , OR click on Search. (2) The search will find any name that matches the 
letters you type in, wherever they appear in the ship’s name. For example, if you type 
“tain”, it will find names that include “Captain”. 

 
Example search for ship “Baltic Captain I”... 

The system searches and displays a list of matching names. (3) 

 To view the details of this Ship, click on the required Name in the list. (3) 

 If the name does not appear in this view, click on Next at the bottom of the Ship 
Directory screen. Wait for the screen to refresh and show you the next set of 
matching ship names. (To return, click Prev to see the previous set.) 
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The Ship Information screen appears: 

 

Note: The blue Commercial Information links are not active in this version. 

 When you have finished, click OK to return. 

Change number of rows to view Rows to view Number of rows 

The Ship Directory screen shows you a preset number of rows of search data. 

 

 To change the number of rows to view, click in the Return  rows field, change 

the number and press . 

 
Check your key phrase selections. 

    – Do you agree? 

    – Did you miss any? 

    – Did you mark any that would not be valid? Why are they not valid? 
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 Off the shelf: further reading 
If you would like to read more about Technical Writing, here is a book list. 

Books about Good English 

 The Elements of Technical Writing – Gary Blake & Robert W. Bly.  
Published by Longman. 

 The Economist Pocket Style Book – Economist Publications. 

 The new language in International Business: Simplified English  
– Tedopres International BV. 

 The Penguin Guide to Plain English – Harry Blamires. 

 Eats Shoots and Leaves – the zero tolerance approach to  
punctuation, by Lynne Truss. (Good fun!) 

 The Penguin Dictionary of English Grammar – R. L. Trask. 

Books about Mind Mapping  

 Mind Maps at Work – Tony Buzan, Thorsons Publishers (Harper Collins). 

 How to Mind Map – Tony Buzan, Thorsons Publishers (Harper Collins). 

Technical Writing Organisation 

The Institute of Scientific and Technical Communicators (ISTC) is the largest UK-based 
society for professional communicators. Web site www.istc.org. 

George Orwell’s Writing Tips 

George Orwell is one of the finer writers in the English language. He is famous for such novels as 
“1984” and “Animal Farm”, and such essays as “Shooting an Elephant” and his memoir “Down and 
Out in Paris”. 

Orwell was a passionate defender of good writing. Here are some of his writing tips. 37
 

A scrupulous writer, in every sentence that he writes, will ask himself at least four 
questions, thus: 

1. What am I trying to say? 
2. What words will express it? 
3. What image or idiom will make it clearer?  ** 
4. Is this image fresh enough to have an effect? ** 

And he will probably ask himself two more: 

1. Could I put it more shortly? 
2. Have I said anything that is avoidably ugly? 

One can often be in doubt about the effect of a word or a phrase, and one needs rules that 
one can rely on when instinct fails. I think the following rules will cover most cases: 

1. Never use a metaphor, simile, or other figure of speech that you are used to seeing 
in print. 

2. Never use a long word where a short one will do. 
3. If it is possible to cut a word out, always cut it out. 
4. Never use the passive where you can use the active. 
5. Never use a foreign phrase, a scientific word, or a jargon word if you can think of an 

everyday English equivalent. 
6. Break any of these rules sooner than say anything outright barbarous. 

 
[ ** Note: Not for Technical Writing! Avoid idioms, figures of speech, etc.] 

                                                      

37
 From Orwell's essay, "Politics and the English Language", 1946 
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